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Shakti Office Installation
To install Shakti Office suite in your computer, all you need to do is just follow a

few steps. Insert CD-ROM Disk into the CD-Drive, run ‘D:\Setup.exe’ from the CD-
ROM, assuming D:\ as your CD-ROM drive, or double click My Computer icon on desktop,
double click CD-Drive icon and double click the Setup icon and follow the instructions.

In the next screen you will see the Shakti Office logo and three buttons named
Back, Next and Cancel. Click on the “Next” button to proceed (press Cancel button to
stop Shakti Office installation). Now click Next button to read the license agreement.

After reading the agreement in detail, click “Next” if you agree with the terms in
license agreement, click “Cancel” if you do not agree.
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In the next screen, you have to input the details for using the Shakti Office
applications and then select the destination folder to install Shakti Office or click “Change”
button and select drive name, folder name. Click the next button to install Shakti Office
in its default location (C:\Program Files\Shakti Office Hindi).
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By choosing the “Typical” option you can install all the applications in Shakti.
If  you want to select applications then choose the “Custom” option. To include the
media files from the Shakti Office CD-ROM (i.e. clipart, sound, background pictures,
etc…), click on “Media”. Then click “This feature will be installed on hard drive”, and
insert the Shakti Office CD-RoM in your CD-Drive. Follow the instructions to complete
the installation. Similarly you can add the SOdraw (Paint Program) application.

Now, you are ready to copy the required files to install Shakti installation in
your computer. Once the files are copied locally to your computer, you will get this
information stating click Finish button to exit the Shakti installation Wizard. Now
click on the Finish button and then click the Yes button to restart your computer.
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Shakti Office Activation
Activation explained

Step 1:  Click on the Start button, Programs, Shakti [Hindi/Tamil/Telugu/…]
and any one of the applications.

Step 2: Now click on the Yes button in the Activate Shakti Message Box. 

Step 3: Then click on the Through Internet Option and click Finish.

 Step 4: Now place the cursor over the Activation Key value and right click Select
All to copy the value. 
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 Step 5: Click on any one of  the links under the Products e.g. Shakti [Hindi/Tamil/
Telugu/…] in www.activateshakthi.com

Step 6: Click on the New User link.

Note: If you have already registered with activateshakti.com please skip
Step 7 and enter the Email ID and Password. This will take you to Step 8.
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Tip: Use the same registered email id at www.activateshakthi.com to retrieve any number
of  passwords for any CD Key.

Step 7: Enter the requested data like Name, Address, City, State, Country, Zip,
Email, Password, Confirm Password and Phone Number. Click on Submit
button.
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Step 8: In this screen, Enter the CD-Key, then you can either enter the activation
key or paste (refer Step 4) and then click on the Get Password button.

 

Step 9: N o t e  d o w n  t h e  v a l u e  d i s p l a y e d  i n  t h e  P a s s w o r d  e . g .
PTNLHCRSM4ILPHUH.

 Step 10: Enter or paste the password collected from internet in the Activate Shakti
– Password and click OK.

 

Shakti has now been activated in your computer..

Thank you for choosing to activate Shakti.
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SOwrite
Shakti Office has a Word Processor; using this you can create and work with

attractive documents.

1.1. How to start SOwrite

To start this SOwrite, all you have to do is click on the “Start” button at the
left bottom corner of  Windows 9x/NT/2000/ME/XP desktop, select the “Programs”
option of the start menu and click on “Shakti Office Hindi”, and “SOwrite”. SOwrite
opens a new document.

 Tip: -  Click on “Start” button, click “Run”, and type “C:\ProgramFiles\ Shakti Office
Hindi\CKWp.exe” in the Open text box.
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1.2. Creating your first document

When you open SOwrite, it will take you to a screen which looks like the picture
shown below. The Application Window consists of  the Title Bar, Menu Bar, Standard
toolbar, Ruler, Edit Window and Status bar. The Edit window is the blank area where
you start typing your text.

Title Bar: The Title bar is always visible at the top of your screen, as long as
the monitor is turned on. this Title bar is important; SOwrite places the name of
the document you are working on, in this title bar. It is a quick way to identify your
current document. The title bar has three buttons (Minimize, Maximize/Restore,
and Exit) that control your SOwrite window.
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Note:-  By default any document that you create will have a name as
Document n, where ‘n’ stands for the number. As you begin with SOwrite,
it will be Document 1 till you save it in a different name.

Menu Bar: Take a look at the row of  words at the top of  your screen.
File, Edit, View, and the other words that folow make the menu bar. It is
called the menu bar because it has a bunch of menus and they organise
the features of  SOwrite. So, when you need something from SOwrite like
printing or adding a footnote, just look inside these menus. Single click
the mouse and the menu opens, and then click the feature or command
that you want.

Standard Toolbar: Standard toolbar displays all the shortcut options in
the form of  icons. The often used options like creating a new document,
opening an existing document, saving a document, printing, cut, copy and
paste text have their respective icons.

Format Toolbar: Format Toolbar displays most of  the options as icons
to perform formatting, such as changing font type, size, alignment, Bullets
and Numbering, etc...

Tip: - To bold face a selected portion of text, first select the text and click on the bold icon
in the formatting toolbar.

The Ruler: Horizontal Ruler helps us to organise the margins and
paragraph indents to set up page size.

Tip: -  The ruler is accurate in size, but the measurement you see is for the future printed
page, not the page you see on your screen. What you see is usually lar ger, and that’s easy on the
eye.
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Status Bar: More interesting information about your document is stored
in the status bar at the bottom of your screen. Most helpful is probably
the page number..

You can click in different parts of  the screen and watch the numbers in
the status bar change. These changing numbers are the coordinates of your
whereabouts of the column, line number, or text cursor position on the
page.

Tip:- Insertion point is a blinking vertical cursor that indicates the position on the screen
where the text or graphics will be inserted.

Table 1.2.1 - The Standard Toolbar Button

Button Description

New Creates a new, blank document.

Open Find and open an existing document.

Save Saves the current document.

Print Prints the current document.

Print Preview View how the current document will appear when it is printed.

Spelling and Grammar Start the proof checking tools in the current document.
Grammar checking is now included here.

Cut Removes the selected text or objects and keeps them in a
temporary memory space known as Clipboard.

Copy Makes a copy of the selected text or object and that enables the
pasting elsewhere in the document.

Paste Insert the cut or copied text or object wherever required.

Format Painter Select the text and click to copy the formatting from one paragraph
and apply that format to another content.

Undo Return to the previous operation.

Redo After an Undo, you might want to Redo the same thing.
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1.3. Create a Quick and Simple Document 

Think of your SOwrite screen as a sheet of paper., and your keyboard as a
typewriter . Now start typing.

Enter text into a SOwrite document: Start a new document and your
cursor falls in place. Start composing the text.  As you type, your words
will appear on the screen. By default the text you type is always aligned
(left justified), which means it always starts from the left margin. Keep
typing, SOwrite automatically moves to the next line as needed. This is
called word wrap, and is a basic feature of  any word processor. Always
press the “Enter” key to start a new paragraph.

Note:- Hold down Ctrl key and press N (Ctrl+N)  to create a new
document.

Tip: -

Press Enter only when you reach the end of a paragraph or to insert
a blank line. If you want to divide an existing paragraph into two, move the
cursor to the dividing point (between sentences) and press Enter. In case if you
want to put those two paragraphs together, move to the first letter of the second
paragraph and press Backspace.

Use the spacebar to insert a single space between words or sentences.

Do not use the spacebar to indent or center text on the page.
Lot of people do it without realising that different fonts assign different sizes to
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the space. If you mix fonts, text will not  line up or center properly.

Press Tab (not the spacebar) to indent the first line of  a paragraph.
Spaces are not just blank holes on the page, they are real characters. Depending on
the fonts you choose for your text, your paragraphs can look uneven if you use the
spacebar to align them. Using the Tab key enables SOwrite to align precisely the
way you want.

1.4. Save your document 

Before trying to print your new document, the golden rule is to first save your
work. Saving a document is simply making sure that everything you see on your screen
is recorded inside your computer, so it’s there whenever you want it.

Click the Save button on your toolbar or press (Ctrl+S). SOwrite understands
that you want to save your new document, but it needs some information from you.
Type in a new name , so you can recall it by that name when you need it. It is necessary
to pick the format in which it has to be stored, i.e. Rich Text format (*.rtf), Word
Document (*.doc), Hyper Text Markup Language which supports web viewing (*.html),
Unicode Text  Document (*.txt), etc…
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1.5. Opening a document to edit 

You can open any document created with SOwrite for further editing, printing,
and so on. To do so, select “File” menu, “Open”, or click on the “Open” button
(icon)  in the standard toolbar or press (Ctrl+O). The Open dialog box will be
displayed as shown below. Enter the name of  the file to be opened in the name box
or its name in the File name list and press OK.

Note: - To retrieve a file from a different directory, select the desired
directory, click the file name and press OK button.

Tip: - We can also open the files quickly by using the list of  most recently used files.

1.6. Saving a document with different name/location on disk

 This enables you to open an existing document, make changes to it, and save
that as a new document, keeping the old one intact. Saving the document for the
first time is little different from using the Save As, because you must give your creation
at least a different name or place (folder) from the original. After that you “Save” as
often as possible, or have SOwrite do it automatically for you with Auto Save.

To save a document under a different name, click on File -> Save As. SOwrite
displays the Save As dialog box, so that you can type a new name for the document
or choose some other folder in which you want to save it and then click on the save
button.
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Tip: - Sharing a document with someone who doesn’t have SOwrite? What do you do?

Naming limitations may still exist if you need to share files with a friend who uses
a ver y old computer and an old word processor. Old programs have a hard time with
longer names. For example, if  you name your document “monthly report for January”,
the letters on display may hust be MONTHL~1.  A better name in this case will
be JAN_REP or anything similar that fits in the eight-character DOS limitation.

To find out the DOS equivalent of a document name that is longer than eight
characters, right-click your document and choose the properties command from the
shortcut menu. It shows you the MS-DOS equivalent filename.

1.7. Exiting SOwrite

You can open more than one document in SOwrite. Whenever you want to
close a document follow these steps. Click “File” menu, “Close”. This will close the
active document. If the document has any unsaved information you have to confirm
whether you want to save the file or not. Then select “File” menu, “Exit” to quit
SOwrite.

Note: - When you think you’ve had enough, give your computer a few
more seconds of your time. Don’t just turn the power off, or you may
have an unfortunate surprise (like corrupted document) waiting the next
time you start the machine.

1.8. Send e-mail in English

Word Processor has the facility to send
email in English. Connect to the internet using
your Dial-up Connection. Select “File” menu,
“Send Email” and then enter TO (email
address), subject, message and the document
will be attached to the mail by default.
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Note:- CC (Carbon Copy) helps to send the same mail to another person
and BCC (Blind Carbon Copy) does the same, but here the receiver will
not know who else are geting the same email. We can attach some image
files, documents, compressed files (*.zip), etc... by using the attachment
option. In the content area, input the message and press the “Send”  button.
A message box will appear to confirm you that your email has been sent.

1.9. Page Setting

The default size of a document page is equal to an A4 size paper (i.e. 8½ inch
by 11 inches). Whenever you want to resize the pages of a document, you can follow
these steps. Select “File” menu, “Page Setup”. The Page Setup dialog box is displayed.
This displays the default margin value for the current page with Top and Bottom
margin value  as 1", Right and Left margins as 1" each. If you want to resize the
page, choose an appropriate page size from the available list (Letter, Legal, A4, etc…)

1.10. Print Preview

Print preview displays exactly what your document has and how it will look
when printed. Select “File” menu, “Print Preview”. The current page is displayed in
preview mode. To view the next page, click the next button.
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1.11. Print Settings 

To print a document, you must install a printer and that has to be turned on-
line. Once your printer is ready, follow these steps to print the entire document, select
“File” menu, “Print” or press Ctrl+P. The Print dialog box will help us to select
more detailed information and  select OK to print the document. You can set the
quality of  printing (Low, Medium, High, Draft), Paper Orientation (Portrait -orients
the print vertically, Landscape - orients the print horizontally).

Speedy printing: To print one copy of  the entire document without going
to the Print dialog box, click on the Print Icon on the Standard Toolbar.

Printing a part of  the document: You can print either page by page or
a range of pages from a document. This facility helps us to check the
result of  our formatting in the document. To print specific pages, follow
these steps:

To print a single page, position the insertion pointer anywhere on the page
to be printed.

Select the page button under the page range. Select all to print each and
ever y page. Select Current Page to print the page the insertion pointer is
on and select OK.
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1.12. Help

SOwrite provides extensive help topics and tips to complete your tasks easily.

1.13. Editing a document

SOwrite gives you the chance of correcting any mistakes or editing the text.
In case of  errors, you can erase them by using either backspace or delete key. Before
beginning to edit,   place the cursor at the location where changes have to be made.

Table 1.13.1. - Moving around in a document

Movement With Mouse Through Keyboard

To move up or Click on the up or Press the Up or Down
down by a line. down arrow button arrow keys given on

on the vertical keyboard.
scroll bar.

Keep button pressed Keep those keys pressed
for faster movement. for faster movement.

To move up or Click on the ribbon Press Page Up key for
down the screen. (the path between moving one page up,

the up and down arrows) and Page Down key for
of the vertical scroll bar, moving one page down.
above the box to move up
by one screen and visa
versa.

Move to the Drag the box on the Pressing Ctrl+Home,
beginning or end scroll bar to either the top goes to the beginning of
of the document.  or bottom in the bar. the document and

Ctrl+End goes to the end.

To move insertion Place the cursor and Press Home key for the
point to the starting click either at the start and visa versa.
 or the end a line. beginning or end.
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Table 1.13.2. - Selecting text in a document

Item      Method

Plain Text Click mouse at the beginning of text and drag to end of text.

Word Double click anywhere on the word.

Line Move the mouse pointer to the extreme left edge of the
document. Shape of  the pointer changes into an arrow. Click the
mouse to select entire line. Drag to select additional lines.

Paragraph Double click at the selection area. (or) Triple click anywhere in
the paragraph.

Entire Click mouse in selection area while pressing Ctrl Key (or)
Ctrl+A document

Graphics and Click anywhere within the object.
other objects

1.14. Undo and Redo  

Whenever you start typing text, it may contain some typographic errors. To
eliminate these errors, SOwrite helps you to undo the last action with its feature
called Undo. You can undo or cancel any action easily. For example, if  you have applied
the Bold face format for a selected portion of text and now you want to cancel the
bold format, just click the Undo tool button in the standard toolbar or select “Edit”
menu,“Undo” option immediately.

Redo is similar to undo. To redo the undone task, selecting “Edit” menu,
click on “Redo”  or click the icon in standard toolbar.

1.15. Moving or Copying Text

When you move or copy, the text is saved temporarily to the clipboard from
where you can paste the same in a new location.

Move text   

First select the text and then select “Edit” menu, “Cut” or click on the cut
icon from standard toolbar (or press Ctrl+X). Locate the insertion pointer in the
document and select “Edit” menu, “Paste” or click on the paste icon from the standard
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toolbar (or press Ctrl+V). The text is moved from its origional place and inserted
in another place.

Copy text  

Select the text, then select “Edit” menu, “Copy” or click on the copy icon in
the standard toolbar (or press Ctrl+C). Locate the insertion pointer in the document
and select “Edit” menu, “Paste” or click on the paste icon in the standard toolbar
(or press Ctrl+V). The text is retained in its place and duplicated in the new place.

Tip: - What is the difference between moving a text and copying a text?

The difference between moving a text and copying a text is that when you move it,
it gets deleted from its original location and inserted in a new location. When you
copy text, the original text remains in place, while you insert a duplicate of it in
a new location.

1.16. Find and replace some text in a document 

This feature comes handy when you, search for any word in the document.
SOwrite has the facility to search, words with match case, up and down in a document.
To do this, select “”find” in Edit” menu (or Ctrl + F). Type the word in the Search
text box. Keep clicking on the “Find Next” button to find all the places where the
word has appeared in the document.

To replace any word with some other word: Whenever you need to search
for specific text in a document, and automatically replace each occurrence of it with
the new text, select “Find and Replace” in “Edit” menu (or Ctrl + H). Type the
word in the Search (Find what) box. Type the word in the Change (Replace with)
box and click on Replace button.
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Find Whole Word Only: This option, will help you find words, that have
the same letters. For example, when you type “temp” the  words likely to be highlighted
will be “temporary” or “attempt”.

1.17. To easily navigate between different pages

SOwrite offers “Go To” feature, which makes navigation inside the document
easy. This feature normally uses the page number to navigate (use “Edit” menu, “Goto”
or press Ctrl +G).

Note:- Even if you haven’t given the page numbers, SOwrite automatically
numbers every page.

1.18. View the Standard toolbar, Formatting bar

Displays the Standard toolbar (ICONS) for the frequently used commands.

Displays the Formatting bar (ICONS), which helps to format text or paragraph.

1.19. How to break a page

In a document one page is separated from another by using “Page break”.
You can manually insert a page break wherever you need by selecting “Insert” menu,
“Break”, “Page Break”.

1.20. Insert date and time in your document

It  is common practice  to place the date at the top right corner of an official
letter. SOwrite makes this simple. Click on the Align Right button in the format bar,
and then open the insert menu, select the Date, Time.
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1.21.  Header, Footer

A header is information that can be printed in the top margin of  a page. Typical
information included in a header includes book titles, chapter headings, and sometimes
page numbers. A footnote or footer contains information such as page numbers,
file created date, file name/path, etc., and are printed at the bottom of the page.

(e.g.) Header information

CK Technologies Pvt Ltd.,

#2, Reddy Colony

Ramalingapuram

Chennai 600012

Footer information

Page No. 01

14th April, 2004
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1 . 2 2 .  I n s e r t i n g  a n image

Select “Insert” menu , “Picture”, “From file” and select the image file (*.bmp.
*.jpg, *.wmf, *.emf, *.gif). To resize the picture select any image and click on the
“handle/grip” and drag it.

1.23. How to Format the Font

Character formatting is the process of changing how a character/word should
look in a document. For example, character formatting can make a word bold, italic,
or underlined.

You can change the size of  text (its point size), make it either bigger or smaller.
You can change the font style by choosing a different font name; for example Arial,
Times New Roman, Tahoma, etc… Select the content and then click on the “format”
menu,  click “font” to change the font name and style.

Using Bold, Italic and Underline: To type characters in Bold, Italic,
or Underlined, first click the button on the formatting toolbar. Then when
you type, the text will be in the format  you have chosen. When you want
to change the format, click the same button again to proceed   and if
you want to apply any of  the formats to a text that already exists, select
the text, and click any or all of  the buttons in the format toolbar.

Changing Your Font using Format Toolbar: Select the content, click
on the down arrow in the font name box. A list of all available fonts will
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appear in alphabetical order. You can select the style and press Enter. When
you start typing, everything will appear in the new font.

Formatting
Text:

Formatting text means modifying the appearance of  text in a document.
SOwrite provides various formatting tools that help, customise and enhance
the appearance of  the text being typed in a document. For example, the
text can be aligned or assigned a new value for height and width. Different
font styles and font sizes can be applied to the text in a document.

Font Size: To change the font size, you can use one of  the following
ways.

1. Select the Font size in drop-down list box on the Formatting
toolbar or type font size and press Enter.

2. Select the text and press either “[”or “]” in the keyboard to either
increase or decrease the font size.

3. The Font dialog box contains a comprehensive collection of
formatting options.

Strike through - Strikes the selected text

Superscript - Raises the selected text above line and
reduces the font size.

Subscript  - Lowers the selected text below the baseline
and reduces the font size.

Format Painter: You can use the Format Painter to format a document
quickly and easily. The Format Painter copies formats from the selected
text to the text you want to format. For example, if  you have formatted
a line as 12 point Times New Roman, bold italic, underlined and left-
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aligned, rather than formatting each paragraph of  the document separately,
you can use the Format Painter to format the entire document. To use
Format Painter select the formatted text (the text whose format you want
to copy). Click on the Format Painter button in the Standard toolbar. Click
the text to be formatted. The text automatically changes to the copied
format.

1.24. Paragraph Formatting

A paragraph is a collection of  words that ends when you press the Enter key.
This includes single-line paragraphs, such as chapter titles, and section headings. When
you press the Enter key, you are ending the document.

Paragraph Format Continues: When you press Enter to create a new
paragraph, the formatting continues to the next paragraph. Once you make
changes to a paragraph (such as changing its margin settings), those changes
will be effective until you change them again.

Soft or Hard Return: If  you need to move to the next line without creating
a new paragraph (as in a list or an address at the top of a letter), press
Shift + Enter. This inserts a “soft return” making the end of  a line, as
opposed to a “hard return”, which marks the end of a paragraph.

Center lines and Paragraphs on your page: To create a new paragraph
equally distant from the left and right margins, click the center button on
the formatting toolbar. The insertion point moves to the center of  the
page. Start typing and you notice that the words spread out from the center
of  the page. Press enter when you have finished. You can also center any
existing paragraph by clicking anywhere inside the paragraph and pressing
the center button. To change a centered paragraph back to the normal
alignment (aligned with the left margin), click anywhere inside the paragraph
and then click the align left button on the formatting toolbar.

Justifying text: Justification means arranging the typed text in a presentable
way. SOwrite offers four types of  justification options. To change the
justification for one or more paragraphs, first select the paragraphs to
change. Then click on one of  the justification buttons on the Formatting
toolbar.

 Left - Aligns the left ends of lines (Ctrl + L).

 Right - Aligns the right ends of lines (Ctrl + R).
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 Center - Centers lines between the left and right margins (Ctrl + E).

 Full - Aligns both the left and right ends of lines (Ctrl + J).

Aligning text right or left: Most documents are prepared with the text
aligned left, with each line starting at the left margin. It can just as easily
be aligned right for anything like dates that you want to appear at the
top right side of the page.

Changing line and paragraph spacing: You can increase the distance
between lines in your SOwrite document. Normally, all lines are single-
spaced in SOwrite. However, you can quickly change the line spacing of
any paragraph by opening the Format menu and choosing Line Spacing
where you enter the numeral for the number of lines you want.

Indenting a Paragraph: Indentation refers to the distance between edges
of  a paragraph and the margins. SOwrite allows you to individually set
the indent for the left edge, the right edge and the first line of the paragraph.
Regular paragraphs are indented by using the Tab key to indent the first
line. Sometimes you want to indent the entire paragraph. For this, place
the insertion point anywhere in the paragraph and click the Tab on the
Rules. To return an indented paragraph to the original margin, click the
button in the Ruler.

1.25. Creating a Numbered or Bulleted List 

Select the paragraph that you want in the list. Select “Format”, “Bullets and
Numbering” to display the Bullets and Numbering dialog box. Depending on the
type of list you want, click on the bulleting or numbering option that you want and
press OK.



Shakti Office

36

Note:- Type in the list elements and pressing Enter at the end of  each
paragraph. Each paragraph will be automatically numbered or bulleted
as you proceed. At the end of  the last paragraph, press Enter.. SOwrite
will insert an extra, empty list item that will be removed in the next step.

1.26. Setting the Back color or Fore color

Select “Format” menu, “Font”, and pick a colour in the “Fore color” to
apply to the text. Select text and click on “Highlight” or “Font” color to select the
colour.

1.27. Working With Tables 

Tables are made up of  rows and columns. The intersection of  a row and a
column is called a cell. When you insert a table in a document, table borders are inserted
by default. Select “Table” menu, “Insert”, “Table”, and enter number of  rows/columns
you want in that table.

Adding Text in a Table: Position the cursor in a cell and then type the text
or use the arrow keys to go to another cell in a table. Alternatively, Press the
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Tab key to go the right cell, or Shift+Tab to enter text in the left cell.

Selecting Text in a Table: Selecting text in a table is similar to selecting
text in a document. You can drag the I-beam pointer over the text to
select it.

1.28. Inserting Table, Rows and Columns

Place the mouse pointer in any cell, select “Table” menu, “Insert”, “Table”,
Row Above/Below, Column Above/Below and input the text in the required column.

1.29. Deleting the Table, Rows and Columns

You can also delete table, rows and columns as per your requirements. Select
the cells to be deleted and select “Table” menu, “Delete”, “Table/Row/Column”.

1.30. Formatting the data in the Table

Once you’ve created a table and entered some information, you can format it
to suit your needs. Background color highlights the selected table so that it stands
out from the surrounding table. Using the border width you can make the table border
thick or thin.

You can set the text width or gap between a cell’s border and its text for the
entire table or the specified cells, using the Text Gap option. Select “Table” menu,
‘Table Properties” to format the table contents.

1.31. How to mark the text for using them in special features?

Open any document or type in the content. Select the entire text or select all
(Ctrl + A) in the Edit Menu. You can also mark a portion of  text in a paragraph or
sentence.
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1.32. Spell check your content

SOwrite checks a document for spelling errors, in a document.We can manually
start spell checking our document by clicking the “Tools” menu, “Spell Check” in
menu or press function key F7.

The Spelling dialog box displays the misspelled word and suggests alternate
spelling. To correct the misspelling, select the correct word and click the Replace button,
if  the word is okay, then you can click the Ignore button to skip over and continue
spellcheck. SOwrite immediately moves to the next misspelled word, and you can
continue the process until all misspelling have been corrected (or ignored). A message
appears when the process is finished, stating that Spellcheck  is completed.

Note:- Select any word in your document and press functin key F12 to
view the meaning in Dictionary.

1.33. Using AutoCorrect

Using this feature we can make the text corrected automatically as we type, or
to store and reuse them as we use frequently in our document by selecting the “Tools”
menu, “AutoCorrect”. To populate the list of  words in our AutoCorrect, all we need
to do is; first enter the misspelled word say for e.g. “begining” in the Replace text
box and then type e.g. “beginning” in the Replace With text box and now click on
the Add button.

Note:- Checking the option Correct Two Initial Caps will automatically
change the upper case text (first two characters) in a word to upper-case
single character.
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 1.34. Create a simple Index

Once your document has heading styles for all the important parts, you can
generate a table of contents. Start with marking your document and place it exactly
where we want to put the table of  contents (usually up front). Select “Tools”, “Linguistic
Tools”, “Indexing” or press function key F9 to have the table of  contents.
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1.35. Count number of words in the document

Using this feature we can find the statisitical information about a document.
First mark the text and then select “Tools” menu, “Word Count”.

1.36. Mail Merge

Mail Merge is the process of merging one document with a name or address
list to create an almost identical bunch of  new documents. You can also use the Mail
Merge to create letters, labels, envelopes, or catalogs. Organize the address data, merge
it into a generic document, and print the resulting personalized documents. Select
“Tools” menu, “Letters-Mailing”, “Mail Merge”, click on “Use an existing list” and
click “Select” button to use the *.xls file i.e. result.xls. Now select the sheet name in
which we have the data that is used for creating the Mail Merge document.
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Select “All records” and click on the “Insert” button, select the required field
and click “insert” button to add the corresponding field in the document.

Here we can edit the document with the inserted fields in it
and format them to your requirement and click the “Close” button,
to view the message “Do you want to insert data now”, click “Yes” to
merge the data in your document.

1.37. Creating Envelopes and Labels

SOwrite makes it easy to prepare Envelopes and Labels and getting them printed.
We can follow these easier steps to prepare the label. Select “Tools” menu, “Letters-
Mailing”, “Envelopes and Labels” and enter the required details and select the Envelope
size and click “Print”.
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1.38. Create letters using Wizards in SOwrite

Create general, official, personnel, etc… letters with minimum effort, using
the wizards that exists in our SOwrite. Select “Tools” menu, “Letters-Mailing”, “Letter
Wizard’ and you will have four different tabs. In “Letter Format” tab, select the type
of letter and add details in “Sender Info”, “Recipient Info” and ‘Other Element”
tabs like First select the Letter format say for e.g. Elegant Letter, check the date and
select the date format. Click on the Receiver tab, input name, address, etc… Similarly
click on the Sender tab and input the necessary values and press OK. Now modify
the document and print.

Keys

Functions Keys Description
F3 Toggle Input between English and Indian Langauges…

Ctrl+F3 Toggle User Interface i.e. English to Indian Langauges..
and vice-versa

F7 Spell Check

F9 Indexing

F12 Dictionary

Ctrl+F4 Close Window
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Shortcut Keys Description
Ctrl+B Bold

Ctrl+I Italic

Ctrl+U Underline

Ctrl+F Find

Ctrl+H Replace

Ctrl+P Print

Ctrl+1 Single Line Space

Ctrl+2 Double Line Space

Ctrl+5 Set 1.5-line spacing

Ctrl+ ] Increase Font Size

Ctrl+ [ Decrease Font Size

Ctrl+S Save

Ctrl+X Cut

Ctrl+C Copy

Ctrl+V Paste

Ctrl+A Select All

Ctrl+O Open a file

Ctrl+N New file

Ctrl+G Go to

Ctrl+Z Undo

Ctrl+Y Redo

Ctrl+Shift+F Change the font

Ctrl+Shift+P Change the font size

Ctrl+Shift+S Change the styles

Alt+Ctrl+C Insert copyright symbol

Alt+Ctrl+R Insert registered trademark symbol

Alt+Ctrl+T Insert trademark symbol
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SOcalc
SOcalc application includes standard features like automatic recalculation, analysis

of data, tabulation of data, functions etc…

2.1. Getting started with SOcalc

The basic SOcalc document is called workbook. This contains three worksheets
by default. You can start SOcalc application by selecting “Start” menu, “Programs”,
“Shakti Office Hindi”. Click “SOcalc”.A new blank workbook opens.

2.2. Introduction to SOcalc

A SOcalc is a program
that manipulates numbers
and string data in rows and
c o l u m n s .  T h e  m a i n
advantage of using a SOcalc
program is that it enables you
to perform simple row and
column arithmetic. It enables
the storage of data in an easy
to interpret format.

If you are new to the
SOca l c ,  h e r e  i s  a  qu i ck
in t roduc t ion  to  SOca lc .
SOcalc can be used to create
bus iness  p lans ,  bus iness
f o r m s ,  a c c o u n t i n g
worksheets, and virtually any

other document that contains calculated numbers. SOcalc can also be used for statistical
analysis and for creating graphical displays. It can maintain large volumes of data at
a time. A worksheet can contain over 65,536 rows and 255 columns. A single cell can
contain a maximum of 255 characters. Such data management capacities make SOcalc
a powerful application.
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Rows: Rows are referenced by the row number 1:1 is the reference to
the first row.

Columns: Columns are referenced by the column name. A:A is the reference
to the first column.

Cells: A cell is an intersection of a row and column. Cells can contain
various types of  data, such as date, text or number. For example21-Jan-
02, Raja or 1234. However, one cell can contain only one type of data. A
cell is referenced by the name of  the column and row. For example the
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first cell A1 is in column A and row 1. The cell is referenced by first
specifying the column, i.e. A and then the row, which is 1.

Worksheet: Worksheets are sheets that contain rows and columns of  cells.
Users can enter data in these cells in SOcalc. You can have multiple
worksheets i.e. files somewhat related to the same entity in SOcalc. By
default there will be three worksheets in every workbook. These are
represented by an index tab at the bottom of the sheet and can be identified
by their name. You can also have multiple work sheets.

Workbook: A file in SOcalc is called Workbook, with an extension of
.xls. Workbooks are containers that hold one or more worksheets similar
to pages in SOwrite.
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2.3. Working with workbooks and worksheets

By default there will be three worksheets in every workbook. These are
represented by an index tab at the bottom of the sheet and can be identified by their
name. You can also have multiple work sheets. Multiple worksheets help to keep
projects organized within a single workbook. For example in a consolidate budget,
you can create separate worksheets for each department. Placing related data tables
on different sheets makes it is easier to view, format, and print each type of  data
separately in a different format.

Opening a workbook leads to the active window with one worksheet open.
This is displayed in the document window. The window controls are similar to the
other Shakti Office. The title bar is at the top with its Minimize, Maximize and Close
buttons on the right side. Beneath is the menu bar with the commands File, Edit,
View and so on. SOcalc also has two toolbars, which include variety of buttons for
performing common tasks.

2.4. Create a new workbook

Click the File menu, New to create a blank workbook. By default you can enter
data in your local language in the very first worksheet. Some of the basic file operations
like open, close, save, print, etc… are similar to that of Shakti Office – SOwrite
application.

2.5. How to enter text, number, date in your worksheet

You can enter either a value or formula in any of  the cells in SOcalc worksheet.
Place the cursor on a cell and begin typing. Your entry appears in the formula bar at
the top of  the window. Formula bar shows the data value of  the selected cell. Press
(function Key F3) to toggle between regional language and English.
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Once formula is entered in a cell, then the formula bar shows only the formula
and not its value. By default, text values are left aligned and numeric values are right
aligned. Date and time can be entered in ordinary form. Use a slash or a hyphen to
separate the parts of a date. SOcalc treats date as numbers. Dates can be added,
subtracted, and included in other calculations. The format in which the date is displayed
can also be changed.

2.6. Save a Workbook

Click the Save button on your toolbar. SOcalc understands that you want to
save your new workbook, but it needs some information from you. Type in a new
name now, so that you can recognise it next time. It is necessary to pick the format
in which it has to be stored, i.e. *.xls, *.txt, *.html, *.mdb.

2.7. Open a Workbook

You can open any document (*.xls) with SOcalc for further editing, printing,
and so on. To do so, select “File” menu, “Open” or click on the “Open” icon in the
standard toolbar. Then enter the name of the file to be opened in the name box or
click on its name in the File name list and press OK.

2.8. Page Setting

The default size of a document page is equal to an A4 size paper (i.e. 8½ inch
by 11 inches). Whenever you want to resize the pages of a document, select “File”
menu, “Page Setup”. It will display the Page Setup dialog box  and margin setup for
the current page with Top, Bottom margins as 1" each, Right and Left margins as
0.75" each. If you want to resize the page, you can do so by choosing an appropriate
page size from the available list.
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2.9. Print Preview

Print preview displays exactly what your worksheet has and how it will look
when printed. Select “File” menu, “Preview” and the current worksheet is displayed
in preview mode. To view the next page, click on the next button.

2.10. Print Settings

To print a document, you must have configured a printer and the printer must
be turned on-line. Once your printer is ready, select “File” menu “Print” or press
Ctrl+P. You can also set the quality of  printing (Low, Medium, High, Draft)and
Paper Orientation (Portrait -orients the print vertically, Landscape - orients the print
horizontally).

Printing a part of  a document: You can print a range of  cells in your
worksheet.  This can be useful for checking the results of  your formatting
and other spread sheet settings. To print a specific worksheet, first select
the range of cells for printing and select the option “Print what”, “Selection”
and click OK.
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2.11. Editing in a document

Data typed in a cell can be edited by two methods: Click a cell and
then on the formula bar for editing the entry in the Formula bar or start
your editing by placing the cursor at the location where the changes have
to be made. SOcalc helps you to correct mistakes and modify calculation
or formula. In case of  errors, you can erase the mistakes by pressing the
function key F2 and placing the cursor using arrow keys in your keyboard
to input the data.

Erasing Data: To delete a cell or range, select the cell or range and press
delete key, or select “Edit” Menu, “Clear”, “Contents”.

2.12. To navigate between different pages

The first step in using a worksheet effectively is to learn
how to navigate inside a worksheet. By default, A1 is the active
cell location when a worksheet is opened for the first time. The
active cell is shown with a border. In other words, we can say
that the cell pointer is at cell A1. You can navigate to other cells
in a worksheet by using the keyboard, mouse and scroll bars.
The following control keys of the keyboard are used to
navigate inside a worksheet.
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Table - Moving around in a Worksheet

To move Press on Keyboard

Left one cell Left arrow or (Shift + Tab)

Right one cell Right arrow or Tab

Up one cell Up arrow

Down one cell Down arrow or Enter

Up one screen Page Up

Down one screen Page Down

To first cell in a row
(Cell pointer to column A of the active row) Home

Table - Selection inside a worksheet

To Select Action required Action required
Mouse Keyboard

Single Click on cell TAB

Entire row Click on row number Ctrl + Shift + right arrow

Entire Column Click on the column heading Ctrl + Shift + down arrow

Entire Worksheet Click on the empty button Ctrl + A
on the top left corner of
the worksheet.

Range of cells Click on the first cell and Shift + Arrow key
drag across to last cell.

2.13. Undo and Redo

Whenever you start typing data, it may contain typographic errors. To eliminate
the errors, SOcalc helps you to undo the last action with its feature called Undo.
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For example, Raja deposits an amount of Rs. 1,00,000/- at the rate of 9.5
percent, then he will get Rs. 1,09,500/-.  Here,if instead of typing 9.5 you have typed
8.5,you can correct this by pressing the undo icon in the standard toolbar.

Then type the correct value that is 9.5. or select “Edit” menu, “Undo” option
immediately

Then do the calculation part.

Redo is similar to undo. To redo the undone task, select “Edit” menu, “Redo”
from the menu or click in the standard toolbar.

2.14. Moving and Copying Text

When you move or copy, the value is temporarily saved to the clipboard and
you can paste the same in another location.
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Move the data: First, you have to select the data, then select Edit ->
Cut or click on the cut icon from Standard Toolbar (or press Ctrl+X).
Then locate the insertion pointer (different cell) in the worksheet and select
Edit -> Paste or click on the paste icon from the standard toolbar (or
press Ctrl+V). The data is moved from its actual place and inserted in
another place.

Copy the data: Select the data, then select Edit -> Copy or click on the
copy icon from standard toolbar (or press Ctrl+C).Then locate the insertion
pointer in the worksheet and select Edit->Paste or click on the paste icon
from the standard toolbar (or press Ctrl+V). The data remains in the original
as well as the new place.

Tip: - Difference between moving a text and copying: The difference between moving
a data value and copying a data is that when you move the data,it gets deleted from its original
location but is inserted in a new location. When you copy text, the original text remains in
place, while at the same time it is also where you inserted it.

2.15. Find and replace some text in a document

This feature is actually very powerful, because you can tell SOcalc to search for
any text or data value in the document. It offers you choices like searching for words
that match cases, having similar colour and font style. Select “Edit” menu, “Find”
and type the word you are searching Find What box. Keep clicking on the Next button
to find all the occurrences of that word.

2.16. To replace any word with
some other word

Whenever you need to search for specific
text in a document, and automatically replace
each occurrence of it with a new text, select
“Edit” menu, “Find and Replace”, type the
word you are looking for in the,Find what box.
Type the word in the Replace with box and click
on Replace button. The above said feature can
also be used for numeric values.

Find Whole Word Only: Finding a word like ‘temp’ will normally result
in finding all the words which have temp in it like ‘temporary’, ‘attempt’
etc. Checking the Find Whole words only option, will get you the word
you precisely want.
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2.17. Setting row height and column width

Changing Column Width of the cells: Use mouse click on Column A,
and drag until Column A through Column D is selected.

Then  select “Format” menu, “Column”, “Width” from the Format menu
and enter the value, for example 20. This is how the column width is changed for
the selected cells.

Note:-  You can also place the mouse pointer over the line separating
two columns at the column heading and double click to automatically adjust
the column width; or drag the column separating line of the column heading
until the column reaches the desired size.

Changing Row Heights: Click on the row, say. Select “Format” menu,
“Row”, “Height” and enter the value, say 20. The height of the second
row is changed.

Note:- Place the mouse pointer over the line separating two rows on the
row numbers and double click to automatically adjust the row height, or
drag the bottom border of the row heading until the row reaches the
desired size.
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2.18. Go To a particular cell

SOcalc offers “Go To” feature which makes navigation inside the worksheet
easier.

This feature normally uses the row and column number to navigate. For example
enter D4, goes to 4th row, 4th column.

2.19. Sorting the selected cells

One of  the easiest things you can do to a database is to sort it. You can arrange
the information in the selected rows or list alphabetically, numerically or by date either
in ascending or descending order. First block the list, and then Select “Data” menu,
“Sort”.
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Ascending

Descending

Here’s something important to remember: When you perform a sort,
the original order of  records is replaced with the sort order. If  you don’t
want this order to remain permanent, click on the Undo button after you’re
done using the Sort command. If you want to retain the sort and the original
data order, consider saving the sorted table as a new file.

2.20. Clear the selected cells content

What do you do with the data that you no longer need ? clear it.

For this, block the cells that you want to clear and then select

 “Edit” menu, “Clear”, “Content”.
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Suppose you want to cleat formatting but not the data, use “Edit” menu,
“Clear”, “Format”.

The format is removed.

If you like to remove the format and clear the content in the cells, select “Edit”
menu, “Clear”, “All”.

The data and format are removed.

2.21. Few more methods to delete the contents

If you want to delete the entire row or column and move the remaining contents
intact, block the column and select “Edit” menu, “Delete”, click the Entire Column,
and press OK.
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The entire column is deleted.

Similarly, you can block the row and select “Edit” menu, “Delete”, click the
“Entire Row”.

2.22. Add Cell, Row, Column

If  you want to add the student’s group of  study, place your mouse over Column
C and click to block. Then select “Insert” menu, “Cell”, “Shift cells right” and start
entering details. If you want to insert entire rows or columns, choose Entire Row or
Entire Column.

Alternately, if  you want to insert only rows or columns, select “Insert” “Rows/
Columns”.
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2.23. Insert or delete a worksheet

You can add new worksheets to any workbook by just selecting “Insert” menu,
“Worksheet”.Then type the name of  the sheet.  Try deleting any worksheet by right
clicking on any worksheet, and click delete sheet.

2.24. Page Break

Page break helps to separate huge data inside a worksheet to subsequent pages
and printing them.

2.25. How to enter a formula and edit that

Formulas let you perform common Mathematical operations (addition,
multiplication & division) using the values in the Worksheet cells. Remember that
in SOcalc, formula always begins with an equal sign.

The result of the formula is displayed in the cell, where it is entered. The formula
appears as entered in the formula bar.
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If want to find the total for the amount deposited and expenditure occurred,
move to the cell address C8,  type in =C2+C3+C4+C5+C6+C7 and press Enter
Key in your keyboard and type in =D2:D7 for the range of cells.

To change or edit the formula, click in the formula bar or Press Function
Key F2.

Note:- Using Add Icon 

You can also do this by first selecting the range of  cells and clicking in the add
ICON  in Standard toolbar and applying format for cells.
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2.26. Referencing Data

A reference is the address of a cell or a range of cells in a worksheet. For example,
A1 is the reference to the cell in row 1 and column A. By using cell referencing you
can refer to the data of various cells, in a formula. Depending on the task you want
to perform, SOcalc offers the following types of cell referencing techniques.

Relative Referencing: Relative referencing is a reference to the cells in
a formula based on the position of  the cell that contains the formula.

T h u s ,  t h e f o r m u l a
=SUM(B2:B6) in cell B7 becomes =SUM(C2:C6) in cell C7 and becomes =SUM(D2:D6)
in cell D7 and so on. By default, SOcalc uses relative referencing.
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Absolute Referencing: By using absolute referencing, you can refer to
a particular cell value in a formula regardless of  the position of  the cell
that contains the formula. If  you want to refer to a cell by using absolute
referencing, precede the name of the column and row with a dollar ($)
sign. For example, $B$1 means an absolute reference to cell B1.

At times, relative referencing might be a problem while dragging formulas.
In case, in a formula, you want one value to be taken always from the same cell, even
when the formula is dragged to other cells, then absolute referencing should be used.
For example, if the formula =C4+$B$1 is typed in cell D4, and the AutoFill feature
is used to fill cells from D5 to D8 the formula in cell D5 will now be =C5+$B$1.
This means that the value of cell C5 is multiplied by the content of cell B1 and not
C4 due to absolute referencing.

Similarly, the formula in the cell D6 will be = C6+$B$1. You can also use
mixed references by placing the $ sign either before the column name or the row
number. For example, $C5, means that column C has to be absolute and row 5 is
relative, while C$5 means the row 5 is absolute and column C is relative.

2.27. Operators in the order of precedence

Usage of Operators is very common in your formulas to produce numeric
results.
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Arithmetic Operator

+ Addition

- Subtraction

* Multiplication

/ Division

^ Exponentiation  e.g. 3^2 (3 squared) is 9

% Percentage

Comparison Operators

> Greater than e.g. 5>2, returns true

< Less than e.g. 11<15, returns true

= Equality e.g. 12.00=12, returns true

<> Not equal to e.g. 5.00<>4.999, returns true

2.28. Using AutoFill to Copy Formulae

The AutoFill feature displays an AutoFill handle, which is a small plus sign
at the bottom right corner of the active cell (refer figure). It is visible only when you
position the pointer at the bottom right corner of  the cell. This handle can be dragged
to copy formulae.

To copy formulae, using the AutoFill handle, select the cell that contains the
formula, drag the AutoFill handle till the last cell up to which the formula has to be
copied and release the mouse button. The cell references in the formulae change with
respect to the location of the cells that contain the formula.
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2.29. Cell formatting techniques

Formatting a cell: SOcalc records date and time values as serial numbers.
Date (month, day, year), e.g. 24-Sep-2001 (24-Sep-01) when formatted
that is changed as 9/24/2001.

The default font (10-point Arial) holds good for basic data entry, but for any
worksheet that is complex, you need to format the cell and know how to change the
font and size of the data.
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If you select a cell range, you can apply font formatting to the entire contents
of  the selection. You can apply different font attributes to different words and characters
in the same cell. Open the Format Cells dialog box and click the Font tab for access
to all font formats, including some options you won’t find on the tool bar. This
helps you to format the cells, which will make your worksheet look good. Most of
the options on the Font tab of this dialog box are straightforward. Most of the
options on the Font tab of this dialog box are fairly straightforward.

You will find countless uses for rich formatting within cells. You can use
different fonts for different products. This feature is also useful way to insert trademark
and copyright symbols and other special characters within a cell.

To use Text Wrapping: Select the cell range that contains the text you
want to wrap., Choose Format Cells. Click the Alignment tab on the Format
cells dialog box and check the Wrap Text Box. Adjust the vertical alignment
if needed.

For column headings with long and short entries, for example, choose “center”
from the vertical drop-down list. Headings formatted this way seem to ‘float’ instead
of  sitting on the bottom of  the cell. For text in a table, choose the Top format so
that each paragraph begins at the same point. Click OK to apply the new format.
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2.30. Using Border, Boxes and Colors

You can create a distinctive identity for sections of  a worksheet by using borders,
boxes and background colours. Using alternative colors to shading to make it easy
for the eye to tell which entries belong in each row, even on a wide worksheet that
contains many columns of data. The borders, Fill colours, and Font Colour on the
Formatting menu work much as you would expect.

These toolbars don’t give you access to every formatting option, however for
a maximum control over borders and colours, first select the cells or range you want
to formats, then right-click and choose Format Cells.
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1. Before you add any lines, choose a line style-thick, doubled, dotted
or dashed from the Style box at the right.

2. Choose a different border colour, if you like. Colours are most
effective with thick lines.

3. Click the Outline button to add lines in the thickness and the
colour you specified on all four sides of the active cell. If you
selected a range, and click inside to draw borders around every
cell in the selection.

4. Click any of the buttons in the Border section to add one line at
a time, on the left, right, top, or bottom of  the cell, or diagonally,
click again to remove the line.

5. You can mix and match line styles and colours, even on different
borders of the same cell. Click the line style or change the color,
and then click the button in the Border area to change the
style.

6. Click OK to close the Format Cells dialog box and return to the
worksheet.

2.31. Formatting using  AutoFormat

First, block the cells for applying the format using template and select “Format”
menu, “AutoFormat”, and select “colourful 3” in category and press OK.



69

2.32. Adjusting decimal numbers

Select the column for which you want to add decimal places and click on the
comma icon on the formatting toolbar.



2.33. Create and use the custom lists

SOcalc offers a feature that helps you quickly fill cells with data. The Fill feature
fills a range of cells that you select, with the data in the original cell, or fills in a range
of cells, incrementing each successive cell. Fill handle will be seen when the mouse
pointer is placed on the right end square of the selected cell. The mouse pointer
changes to a +.

1. Select the first cell in the range you want to fill, and enter the
starting value or the series. To increment the series by a specified
amount, select the next cell in the range and enter the next item
in the series.

2. Select the cell or cells that contain the starting values.

3. Drag to fill over the range.





Shakti Office

72

SOaccess
3.1. Introduction to SOaccess (DBMS)

Before you start using SOaccess, learn about its capabilities. It is better to
understand what databases are and what a database system means. Databases help
you organise related information in a logical manner for easy access and retrieval.

Every organisation maintains data pertaining to its business, employees and
other entities. This data needs to be maintained in such a manner that it is easily
available and can be presented in any desired format. The data also needs to be updated
regularly.

Database: A database is a computer term for a collection of  related
information about a certain topic or business application, such as employee
database or a product database. Computer databases can store data in
different formats, from simple lines of  text (such as names and addresses)
to complex data structures that include pictures, sounds or video images.

Databases arrange information in such a way that any specific piece of information
can be accessed if a reference point is known. Here, the Product No is the reference
point that can be used to access all other information about the software development.
For example, maintaining software development details is just a SOaccess. Every entry
is arranged alphabetically, whereas a newspaper report cannot be called a database.

Sample Database:

Product No Product Name Developer Duration

001 Address Book Ramu 2 Weeks

002 Hand Writing Recognition Kumar 4 Weeks

003 Text to Speech Balu 2 Weeks

SOaccess involves creating, modifying, deleting and adding data in files to
generate reports. SOaccess allows you to perform these Database Management System
(DBMS). SOaccess user enters data through data entry forms and retrieves it using a
query. Data is formatted in form, and reports are generated and sent to the VDU or
a Printer. Database includes table, record, field, value, form, query and report.
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Table: The information stored in a database is contained in the form of
one or more tables. A table stores data in a row - column format. Every
table in a database focuses on one subject, for example products, customers,
etc... The table is divided into several rows. Each row contains different
Product No, Product Name, Developer and Duration.

Record: Every row of  information is called a record. Every record is a
separate entity and it can be accessed as desired.

Field: Information in columns are known as Fields. For example, the
column Duration is a field that stores the time taken to complete the
product development.

Value: Every specific piece of  information in a table is known as a value.
Thus, Ramu is a value in the Developer field and 2 Weeks is a value in
the Duration field. The total number of values in a table is the number
of rows (records) multiplied by the number of columns (fields).

3.2. Introduction to RDBMS

Relation Database Management System (RDBMS), enables users to manipulate
data in more sophisticated ways. RDBMS avoids redundancy in data and defines the
relationships between sets of data. The relationship is a common element between
tables Product No, which is a common element in a Project Details table and Project
Status table as shown.

Table 1  - Project Details

Product No Product Name Developer Duration

001 Address Book Ramu 2 Weeks

002 Hand Writing Recognition Kumar 4 Weeks

003 Text to Speech Balu 2 Weeks
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Table 2  - Project Status

Product No Status Developer

001 Completed Ramu

002 Not Completed Kumar

003 Completed Balu

The data stored in each table can be retrieved and updated based on data in
another table.

3.3. Introduction to SOaccess

SOaccess is a powerful multi-user DBMS developed by CK Technologies. It
can be used to store and manipulate enormous information and automate repetitive
tasks, such as maintaining an inventory and generation invoices. By using SOaccess,
you can process your data and view the custom reports.

Data in SOaccess is organised in the form of tables. Within a table, records
are arranged according to a common reference value, known as the Primary Key (e.g.
Product No). The value in the Primary Key field is different for every record (Unique)
and thus helps identifying records easily.

For example, the field Product No is the key field. The value in the field can
be used to uniquely identify a Product even if the values in other fields, such as Product
Name and Developer are the same.

Table 1  - Project Details

Table 1  - Project Details

Product No Product Name Developer Duration

001 Address Book Ramu 2 Weeks

002 Hand Writing Recognition Kumar 4 Weeks

003 Text to Speech Balu 2 Weeks



75

Table 2  - Project Status

Product No Status Developer

001 Completed Ramu

002 Not Completed Kumar

003 Completed Balu

A combination of  two or more fields can also be used as the primary key.
Such a combination is called a Composite Key.

Since a value in one table can be replicated across other tables, there should be
a way to maintain a relation between the two tables. This relation is implemented
through the concept of  a Foreign Key.

A foreign key in Project Details table and Project Status table can be related
with the help of the Product No field.

In the Project Details table, the Product No can be stored as a field and can
be used to retrieve the details about the Status of product development from the
Project Status table. Databases in SOaccess have a default extension of (*.mdb).

3.4. Points to be considered for good database design

An important point to keep in mind as you begin creating a database is a good
design. Without a good design, you will be constantly changing the database structure
or you may not be able to extract the information you want from you database. To
create a database, you need to complete a series of steps known as design steps. The
aim of  this process is to produce a compact and efficient data structure accordingly.

You need to design your database in such a manner, that data integrity is
maintained at all levels. Data integrity refers to a state of the database where none of
the data is duplicated or inconsistent. For example, in the Book Collection database,
if  you store the Author’s Name and Address values for all their books, you will have
redundant data. This also increases the changes of inconsistency in the data.



Shakti Office

76

Table: Book.mdb

Book No Title Author Address Price

001 Way to Success Kumar India 300

002 Warrior of  INDIA Jackson U.K. 150

003 Management Radhika India 225

004 Memory Management Kumar India 175

005 I.Q. Kumar India 45

For example, if you are storing the authors’ address for every book, the changes
to the address may not show in every record. Thus, it would be better to split your
data into multiple tables and maintain separate tables for author details and book
details.

Table: Book.mdb

Book No Title Author Address Price

001 Way to Success Kumar India 300

002 Warrior of  INDIA Jackson U.K. 150

003 Management Radhika India 225

004 Memory Management Kumar India 175

005 I.Q. Kumar India 45

Table: Author.mdb

Author ID Author Address

A001 Kumar India

A002 Jackson U.K.

A003 Radhika India



77

Both, the tables can then be related by including an author identification number
in the Books table.

Table: Book.mdb - modified

Book No Title Author ID Price

001 Way to Success A001 300

002 Warrior of  INDIA A002 150

003 Management A003 225

004 Memory Management A001 175

005 I.Q. A001 45

After you have split your database into multiple tables, the next step is to set
relations between them in such a way, that a query can retrieve from multiple tables.

SOaccess does this by matching primary keys with the foreign keys in other
tables. For example, to print a report showing the books and their authors, the query
can match the Author ID in the Author table with the Author ID in the Books table
and generate a dynaset containing all the book details and the author details.

After you have decided upon the tables that you will have in your database,
you can define the various fields and their properties. For every field, you should
decide the:

Field Name

Field Type

Field Size

One of  the most important tasks in a DBMS is ensuring data integrity. For
this, you can define data entry rules and data validations. This would ensure that
only valid and consistent data is stored in the table and inconsistent data rejected.



Shakti Office

78

For example, in the Book Collection database, your data validation rules can
check

for

Entry of 0 in the price field

A blank in the Name or Title field

An Author ID that exists in the Authors table

A Title Type that exists in the list of  titles

A database also consists of various objects like reports that display data. After
you have created the table, you need to enter data and create queries to generate report.

After you have designed the database and table structures on paper, you can
begin creating a database. There are several ways in which you can create a database.
You can create a blank database and add table and other objects yourself.

Alternatively, you can invoke the Database Creation Wizard to create a database.
SOaccess has several database templates, such as inventory control, Address Book
and Order Entry Wizard.
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You can modify these databases to suit your requirements.

3.5. Steps to create Database

As you invoke SOaccess select File menu -> New, enter the database name for
example, book.mdb and press OK. Then the Data Wizard gives you an option to
create a blank database, You can use one of  the available sample databases or select
the blank database.
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Select the Table tab, and click the “New” button.

Now, enter the table name, for example book and click the add field and define
the field information.
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Note:- When naming fields, you need to follow some Object Naming Rules
defined by SOaccess. These rules are naming conventions, maximum width and other
specifications. For example, field names can be up to 64 characters long and can include
any combination of letters, numbers, spaces, and special characters except a period
(.), an exclamation point (!) an accent grave (‘), and brackets ([]). Note that you also
cannot use leading Spaces or Control characters (ASCII Values 0 to 31)

Click on the Add Index button. An index is an internal table of values that
SOaccess maintains to store the order of records. Index objects thus provide efficient
access to data. Database indexes work just like the indexed book. When you want to
find a particular topic in a book, you turn to the index and look up the page number.
Then you turn to the relevant page.

Similarly, in a table, Indexes control the way data is accessed. However, it does
not duplicate the data itself. Nor does it change the sequence in which data is stored
in the table. Now, select the “Book No” field as primary key.
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Then click the build table button to complete the table definition.

Now the table is created.
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3.6. Adding records in a table

Click Open button in the Table tab, and enter data into a SOcalc-like format.
Once you have finished entering the data, you need to save the table. To Save the
table, choose the Save button.

3.7. Data types available in SOaccess

After you name a field, you need to decide what type of data the field should
hold. SOaccess supports eight basic data types. These data types and their specifications
are shown in the table below:

Data Type Type of Data Stored Storage Size

Text Alphanumeric characters 0-255 characters

Memo Alphanumeric characters 0-64,000 characters

Number (Byte) Numeric Value 1 byte

Number(Integer) Numeric values 2 bytes

Number(Long) Numeric Value 4 bytes

Number(Single) Numeric Value 4 bytes

Number(Double) Numeric Value 8 bytes

Date/Time Date and time data 8 bytes

Currency Monetary data 8 bytes

Yes/No Logical values: Yes/No,
True/False, On/Off 1bit(0 or-1)

Auto Number Numeric Value Generate numeric by
automatic
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3.8. Frequently used Data Types

Brief description for some of the frequently used data types:

Text Data is a type of  data that can store all valid printable characters.
Names, addresses and comments are all text data. The default size of text
data type is 50. When you create a table, the size of your largest entry is
set as the field width. SOaccess allocates the same space for all values in
that field, irrespective of  the size of  the data entered. For example, if
you specify 100 characters for the Book Title field, 100 bytes will be allocated
for the value. Thus, if  the Book Title is only, 25 characters long, 75 bytes
will be left unoccupied.

Memo data type holds a variable amount of data, from 0 to 64,000
characters for each record. Therefore, if one value uses 100 characters,
another may require only 10. Space equal to the actual size of the data
value is allocated. If you need to create a text field in which the size of
the values can vary widely, you should use a memo data type.

Number data type enables you to enter numeric data. Numeric data can
be used for calculations. If  you do not need to perform any calculations
with the data, use the text data type.

Currency data type enables you to enter monetary data, such as the price
of  a book. You can specify various currency and display formats.

Date/Time data type can store date and time values. You can display
the date and time in various formats.

Yes/No data type is also known as logical type, stores data that can have
two values. For example, if  you want to store a value that will indicate
whether a book has been issued or not.

Auto Number data type generates numeric value by automatic and the
value will be increment or random.

3.9. Modifying the Table Design

Sometimes changes are necessary to the table design because of change in the
application’s specifications or table structure does not generate the required output.
Therefore, you may want to add a new field, remove a field, rename a field or change
the data type.
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Inserting New Fields: The steps to insert a new field are, in table tab
click the design button, click the Add Field button to insert more fields.
A new field is added to the table design. You can now enter the field name,
data type and description. If you have a query that uses these tables, you
need to add the field to those objects as well.

Renaming Fields: You can change a field name by typing in the field
name text box. However, you must remember that you must also change
the field name in all the reports, forms and queries that you have created.

Deleting Fields: You can delete a field by first selecting a field and then
click on the Remove Field button. Whenever you delete a field, you will
receive a warning from SOaccess stating that you will lose all data stored
in that field.

Note:- Whenever you delete a field, remember to remove references to
that field in  query and other database objects.

Changing a Field Size: Fields need to be resized to hold more data or
to save on database size if the width is more than required. However,
you can resize only the text and numeric fields because all the other data
types have predefined sizes.

To increase the field size: Increase the Field Size property for text fields
by specifying it in the size text box.

Warning: You may lose data if  you reduce the field size or the number
of  decimal places. You should always make sure that the existing data would
fit into the new size.

Changing a field’s Data Type: You need to be very careful while changing
the data type of  a field if  you want to preserve the existing data. You
need to understand four basic conversion types as you change from one
data type to another.

Conversion to Text: You can convert any other data type to text. However,
If  you convert numeric data type to text, you will not be able to perform
any mathematical calculations with the data.

Convers ion f rom Text :  Only  da ta  s tored  as  numer ic  char ac ters
(0,1,2,3,4,5,6,7,8,9) or as periods, commas and currency signs can be
converted to Number or Currency data types from Text type.
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Note:- You also need to make sure that the maximum length of  the text
string is not larger than the field size for the number or currency field
that you have converted.

Text data being converted to Date/Time type needs to be in a correct date or
time format. Check all the date strings for valid dates before converting.

Conversion to Yes/No data type is also possible if  all values are Yes/No,
On/Off  or True/False.

From Currency to Number: You can convert data from Currency to
Number data type, as long as the receiving field can handle the size and
the number of  decimal places. The Double field size can store all currency
values since it holds 8 bytes and 15 decimal places.

Converting Text to Memo: Data can easily be converted from the Text
type to Memo type, because Memo can store 64,000 Characters.

Note:- If  you convert Memo to Text data type, you will lose all the values
(more than 255 characters).

3.10. Editing and Deleting Records

Often we need to replace existing data with new data or delete a record altogether.
To add a new value, type in the value into the field directly. To replace the existing
value   with a new value, press CTRL+Enter or double click any field and start entering
value.

Note:- SOaccess does not allow you to edit certain data types, such as
Auto Number Fields, Calculated fields, and Fields being edited by another
user in a shared database.

You can delete a field or record by selecting it, and pressing the Delete key in
your Keyboard or by clicking the Delete Button. You can select multiple records to
delete by selecting the first record and clicking on the last record while holding down
the Shift key.

Delete a Table: Select the table that has to be deleted and then click the
Delete Button in the Table tab, a context sensitive menu pops up, click
YES button to delete table.
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3.11. Create queries using wizards

The process of accessing the database and retrieving data selectively is known
as querying. The data thus retrieved can then be formatted according to the user
requirements. The primary purpose of any DBMS is to provide accurate information
in a custom format. The efficiency of a database is determined by the speed with
which it retrieves data and presents it in a user-defined format.

In SOaccess, you can query the database to retrieve selective records from one
table or join one or more tables to view a multiple table query. The query can then be
viewed in the result of the default data sheet format as a report. A query is a database
object like tables and forms. The query stores instructions for extracting the data,
such as the selection criteria for retrieving records, and not the data itself. Data is
extracted from the tables when the query is executed.

First, click on the Queries tabs in the Database window, and then click Wizard
button, SOaccess displays a dialog box as shown below

Here, click on the table name Book and click Execute button. This will retrieve
all the records from the table book.

Tip: If  you want to add all the fields in a table to the query, click on the * symbol in the tables
view.
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Finally, you need to save the query by selecting the save button in the query
wizard. Here, enter the name for query and click OK button.

3.12. Advanced Query using wizard

SOaccess provides you some interesting features to extract data. For example,
in table book, fetch the records that are priced either less than 150 or equal to 150
and display the Book No, Title of  the book and the Price. To do this, in Database
Wizard select the Wizard button, select the table name as book, check the Book No,
Title and Price. Now in the Condition group, select the Field name as Price, then
select <= as the operator, and the value as 150. This will show the query as

Select [Book No], [Title], [Price] from [Book] Where Price<= 150
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Click the “Execute” button to retrive the records.

3.13. Structured Query Language

Structured Query Language (SQL) is a database query language. You can also
pronounce SQL as sequel. SQL is a standard language for working with databases.
Suppose we want to get the details of  the book titled I.Q., just type the SQL query
as

SELECT * from BOOK Where Title = “I.Q.”



In this query,

 SELECT * from BOOK Where Title = “I.Q.”

The first part of the SELECT statement specifies the columns to be retrieved.
In this example, ( * ) all the fields are retrieved i.e. Book No, Title, Author ID and
Price columns are displayed. The second part of the SELECT statement names the
table(s) from which the query results are pulled. Here, the query is executed against
the table named book.

Finally, the Where clause of  the SELECT statement specifies the criteria to
use when retrieving the records. In this example, the selection criteria specifies that
only record where the value of  the title column is equal to “I.Q.” should be retrieved.

Note:- SQL can also be used to specify multiple table joins on the basis
of  foreign keys, record selection criteria and data groupings.

3.14. Use SOaccess to create Reports

In SOaccess, Print preview is a flexible way of viewing and printing summary
information. It enables you to display information to the required level of detail.
To view the Print preview, select “File” menu, “Print preview”.

3.15. Identify the need for Primary Key and Foreign key

Relational Database Management Systems uses associative addressing, i.e. it
identifies and locates rows by values. The physical address is transparent to the user.
Therefore, relational systems require keys that can uniquely identify the rows of a
table.

Any attribute or set of attributes that uniquely identifies a row in a table can
be a candidate for the Primary Key. Such an attribute is called a Candidate Key.
One of  the candidate keys is chosen to be the primary key, based on familiarity and



greater usage. Any attribute that is a candidate for the primary key, but is not the
primary key, is called Alternate Key.

It is important that you understand that the primary key is the only sure way
to identify the rows of a table. Hence, the alternate key may have NULL values. NULL
Values, it would become difficult to identify uniquely the rows containing NULL
values.

Foreign key is an attribute existing in a table and the same attribute is
primary key in another table. Foreign key always represents relationship.

Table: STUDENT

STUDENT_N0 SECTION TEACHER

100001 III 6001_a

100002 IV 6002_b

100003 II 6003_c

In the above figure, STUDENT_NO, SECTION, are both individually unique.
Therefore, they are both candidate keys. If STUDENT_NO is chosen to be the primary
key, then SECTION is the alternate key.
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SOmail
4.1. What is Internet?

Internet is the network of networks for communicating with one another over
fiber optic cables, telephone lines, satellite links and other media.  Internet is an
information superhighway freely available to everyone desirous of using it, and has
seemingly compressed the world into a cyber colony. It is also a coordinated union
of networks available over the entire world.

Internet has had a major impact on the Information Technology industry.
Computer users around the world, who are on the internet, can contact one another
just like telephone subscribers do and share information.

Internet Society (ISOC) coordinates the activities of several agencies to bring
order and give direction, formal rules. “Internet” refers to the global information
system that is logically linked together by a globally unique address space, based on
the Internet Protocol (IP) or its subsequent extensions. It supports communications
using the Transmission Control Protocol/Internet Protocol (TCP/IP) suite or its
subsequent extensions and other IP-compatible protocols. It provides users accessible
either publicly or privately.

Here are some of  the ways the Internet can be useful to you:-

Exchange E-mail with any of the tens of millions of people with E-
mail addresses.  There are estimates that about 40 million people are on

the Internet.

Search for, retrieve, and read literally millions of files stored on computers
throughout  the world.

Search for and bring to your computer shareware, freeware, and
commercial software.

Search databases of governments, individuals and organizations for files
on tens of  thousands of topics.

Join specific topic-oriented discussion groups (known as Newsgroups,
about 15,000 to 20,000 of them are there).
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Send and receive program data files such as desktop publishing files,
Spreadsheets, CAD files or word processor files, which you or the receiver
can immediately start to work on.

Send or receive sound, animation and picture files from very distant places

Set up temporary or permanent discussion or work-oriented groups

Browse through resources of  private or public information services that
are on the Internet.

Communicate in real time, with others connected to the Internet.

Set up a site with information about your company’s products and services.

Browse and search “catalogs” of  goods and services, and purchase items
on line.

Conduct test marketing.

Distribute/read electronic publications.

Sell products and services.

4.2. Different modes of  internet access

Internet service providers offer different kinds of  services and connections.
The type of connection chosen by the user depends on the purpose for which they
intend to use it.

Dedicated Access: A dedicated connection allows the user’s computer
to remain connected to the internet 24 hours a day.

ISDN: Integrated Services Digital Network (ISDN) is a high speed fully
digital telephone service that works over existing copper telephone wiring.
It operates up to 128 kilobits/second, which is five or more times faster
than the analog modems. ISDN can dramatically speed up transfer of
information over the internet connection, especially rich media like graphics,
audio or video applications.

DSL: Digital Subscriber Line (DSL) is a broadband communication
technology for use on regular phone lines and is capable of  moving data
over the phone lines up to 140 times speedier than the fastest analog modems
available today.
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Dial up Access: User can have two kinds of accounts – SLIP (Serial
Line Internet Protocol) account and PPP (Point-to-Point) accounts.

Shell Accounts: User can access the internet for a fixed number of hours
and they have to pay a monthly or annual tariff  for the services rendered.
These users can only view text and not graphics.

DNS: Domain Naming System (DNS), IP addressing system uses country
codes comprising of  two letters. Examples of  country codes are .in for
INDIA, .ca for CANADA, etc…

TCP/IP: A user needing access to the internet through a service provider
us ing  d i a l -up  access,  ca l l s  up  in te r ne t  se r v i ce  prov ider ( ISP)  on
telecommunication channel, and then the ISP connects user’s machine to
the internet after assigning a unique IP address.

This popular method of accessing the internet using dial-up access:

TCP: breaks up the data to be sent into little packets. It guarantees
that any data sent to the destination computer reaches intact.  It makes
the process appear as if one computer is directly connected to the other
on a dedicated circuit.

IP: is a set of conventions used to pass packets from one host
to another. It is responsible for routing the packets to a desired destination
IP address. Packets are passed using three kinds of  mechanics, i.e. bridges,
routers and gateways.

PSTN: Modem does the job of  converting the computer’s signals to analog
signal for transmitting over PSTN and vice-versa for receiving the signals
using PSTN at speed up to 33.3 kilobits/second.

4.3. Minimum requirements for internet connection

The following is the minimum software/hardware that needs to be installed
on a user’s machine for connecting it to the internet.

Software

Dialer Software

TCP/IP Protocol

Browser – Web Browser, Internet Explorer, Netscape Navigator
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Hardware

A PC-AT 486 or higher with SVGA capabilities

Large hard disk space for downloading files

A Modem that handles faster transfer rate

Sound card, Speaker, Microphone for better experience

Telephone line for dial-up access

4.4. Create a new E-mail ID

Electronic communication is fundamentally different from paper-based
communication because of  its speed and broadcasting ability. E-mail enables you to
communicate quickly and easily with friends and colleagues at another location, and
around the world. The use of SOmail is rapidly increasing, changing the way of
teaching, learning, research, health care, business, and administration.

E-mail is the most widely used application of  computer internetworking, today.
The speed with which it reaches its destination, and its low cost allows people to
exchange information on day to day happenings in their businesses, professions,
and private’s life. As E-mail becomes a part of  routine, It becomes pivotal to understand
how it works and what may be expected of it.

The first step is to enter the web site address, for instance as www.yahoo.com
to get into the site which offers free email id and create an account for yourself.

4.5. Configuring user account in SOmail

Select “Tools” menu, “Accounts”, “Add” and enter the required information,
fo r  example ,  name,  ema i l  i d ,  SMTP ( smtp.ma i l . y ahoo.com) ,  Pop  Hos t
(pop.mail.yahoo.com).
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4.6. Send a mail with attachment

Now you are ready to compose a
new email to anyone in the world.  On
the “File” menu, click “New”, “New
message” to enter recipient name[s] in the
To, Cc, and Bcc boxes, and type the subject,
and start typing the message. Then click
on the attachment icon to add files, and
select the file as attachment and then click
OK and click “Send”.

Note:-  You can send a message to recipients by separating their e-mail
names with comma(,) in the To, Cc, and Bcc boxes.

To: Message is sent directly to the recipient.

Cc: Carbon Copy. A copy of  the message is sent to the recipient, and
the recipient’s name is visible to other recipients of  the message.

Bcc: Blind Carbon Copy. A copy of  the message is sent to the recipient,
and the recipient’s name is not visible to other recipients of  the message.

Do you want to reply for an e-mail: Open the message you want to
reply to and click “Reply” button.

4.7. Preference settings in SOmail

Some preliminary settings can be done here for easy mailing by selecting “Option”
menu, “Preferences”, and select

Save Email address, saves the address or IDof every mail that has been
sent.

Delete from server, deletes the mail in server after downloading it in
your system

Copy of sent mail, retains a copy of every mail that goes out from SOmail



Encrypt/Decrypt, helps secured mail transfer from SOmail  and only
the authorized person can access that particular mail.

4.8. Customizing Message Rules

Here we can define certain set of instructions for arranging the mail in their
respected accounts.

For example, if there is any mail from info@chennaikavigal.com with the subject
specified as Activation, Password, etc… SOmail will direct them to Activate Shakti
folder.



4.9. How to delete junk or unwanted e-mails

Click Inbox, select the messages you want to delete and press “Delete” in your
keyboard.

4.10. Save E-mail as HTML file

Open the email message and select “File” menu, “Save As”, then select the
HTML format and enter the file name and click OK.

4.11. About importing information into SOmail

You may want to bring in existing information from another external data
file (*.dbx), for that import the information stored out in *.dbx file and we can add/
modify information to those files using SOmail.

4.12. Block mail

We can restrict unknown/junk/unwanted emails coming from any address
by specifying the address in the Block sender’s list. To do this, Select “Tools” Menu,
”Message Rule”, “Block sender’s list”, and click “add” button to add the sender’s
email address.
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4.13. Find email based on ID, subject, message

SOmail provides various methods of searching information in your mail. Select
“Edit” menu, “Find”, enter the subject i.e. Activation and press “Find” button to
list all occurances.

4.14. How to use address book

The Address Book provides a convenient place to store contact information
for easy retrieval of  email id’s based on the email name. To add new addresses click
on “Tools” menu, and select “Address Book” and add few contact address with name,
email id, phone number, designation, company, etc… in various tabs like home,
business, personal.  Later these address entries can be used to fill the appropriate
address while creating or composing the mail to either a single or to a group of persons.

4.15. How to send/receive emails

Select “Tool” menu, click  “Send/Receive”, or press Ctrl+ M,  this will prompt
the user to enter the password for that email account. The account will starts receiving
mails to that configuration and sends the pending mails from the outbox.
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SOshow
5.1. Introduction to SOshow

SOshow is an application used to present computer-based presentations.
Presentations help to self-run or display diverse information in a clear and concise
manner. There are various circumstances in which a presentation is made: teaching a
class, introducing a product, explaining an organisational structure, etc. When
performing a presentation, there are different kinds of presentation like before an
audience, handouts in printed format or email to specific audience. The preparation
for each and the actual delivery of the same are quite different.

User-friendly presentation will meet today’s competitive business environment.
Using this application we can create presentation that has text, image, audio, and
video. Presentations can have speeches, sales pitches and information about meetings.
Before getting into the details of each, here is a look at the software and what it has
to offer.

SOshow uses slides that are already laid out for us with placeholders where
the user can insert various objects while creating the presentation. Each placeholder
has text in it and the type of  object it is designed to contain. You can alter the
placeholders on any of the Slide to your requirement.

Slide Layout can be determined before creating the first slide in your presentation,
and with the facility to alter them.Designing the basic Slide Layout is very simple
and applying various kinds of formatting to text with paragraphs, bulleted list of
key points, coloured text, adjusting line spacing, images, and drawings. Detailed
statistics in the form of graphical objects can also be formatted using this application.

Once the slide creation is completed you we can view the presentation, that is
theSlide Show. Animation, transition to slides and printing the slides for handouts
(used to distribute across audience during show) are some of the features available
in this presentation software.

5.2. Advantages of using SOshow

SOshow has many tools in common with SOwrite: If you are familiar
with the word processing program SOwrite, you have a head start in learning
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SOshow. Many of  the toolbar icons in SOwrite are present in SOshow
and execute the same functions.

Quick and easy to create: If you have never used SOshow before, you
may be surprised at how easy it is to create a presentation having content
in both English and Indian Language.

Requires little ef for t to update information: Since the sl ides are
computer-generated (as opposed to 35mm slides), you  can also modify
that any time.

Easy to transport: Depending on the file size of your SOshow presentation,
you can carry them in either a floppy disk or even email them it to another
person/location.

 Create instant handouts: Using printing options, you can give the audience
copies of your presentation slides on paper

5.3. General steps for creating a good presentation

It is important to consider how your content will adapt to a series of
slides.

Filling a slide with too much text can easily make it look cluttered and
difficult to read.

Try to think of  your slides in terms of  outline points and detail them if
necessary to your audience either verbally or on another slide.

To sustain interest and reinforce the message in  your presentation you
should  incorporate elements from other media such as; clip art, animation
and sounds.

Streamline the slides so that the audience requires minimum effort to
read and understand the presentation.

Create new slides and enter text.

Apply any one of the Design templates to the slide.

Format each of  the slides individually, if  necessary.

Add image, audio and video, statistical information to the presentation.
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Apply slide transition, animation effects and use hyperlink.

Rehearse and adjust slide timings for slide show.

In many cases, a successful presentation will follow the standard structure.

It will have a beginning slide, in which the title, expected outcomes are introduced.

Then it will have content or data slides in which topics are expanded upon and
supported by details.

Finally, it will have an end slide or summary slide in which connections are made
between the topics and conclusions are drawn to confirm various convincing
arguments. The presentation may end with thanks and a closing salutation.

5.4. Starting SOshow

Click on the “Start” button, select “Programs” option, click option “Shakti
Office Hindi” and then the “SOshow” icon.

A presentation consists of a collection of slides. The primary unit for storing
objects is the Slide. Each slide contains one or more objects, such as title text, subtitle
text, drawings, images, etc… Each object in a Slide can have associated formatting,
such as font style, size, color, highlight  colour and animation effects.

To give presentations a consistent appearance, this presentation software uses
AutoLayouts. After selecting the presentation type, you can apply layout for them.
These layouts include different types of bulleted lists, text and images.

These AutoLayouts insert specific content at predefined placeholders on a
slide (e.g. title, subtitle) and they are part of  the presentation software user interface.
However you can modify either the content created in it or the entire layout itself for
any slide.

Note:-

Presentation files Save the file in a format called (*.ppf), open and edit
these  files in SOshow.

Content templates Presentation template (*.pof)
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5.5. SOshow user interface

Presentation application user interface or work area has much in common with
our other Shakti Office Suite applications, such as SOwrite, SOcalc, etc...  The basic
menus, standard toolbar, formatting toolbar are more or less similar.

Tip: To change the position of  a toolbar, click on the vertical bar at the
left side of the toolbar and drag it to a new location.

Drawing Toolbar: The buttons in this toolbar are used to draw lines,
shapes and to change the properties of  those objects.

Status bar: It displays the state of the NumLock,CapsLock and ScrollLock
keys.
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Task Pane: Click “View” menu and select “Task Pane”. It lists all possible
commands that are relevant to whatever we’re doing in Presentation. You
can easily hide Task Pane by clicking the close button in the upper-right
corner of the task pane to have more room to view presentation.

Slides: Slides are individual “pages” of a presentation. Slides can have
titles, subtitles, text, drawing objects, clipart, audio and video files created
using other multimedia applications too.
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Placeholders:  Placeholders are plain text or graphics boxes provided
as prompts and each prompt indicates what type of text or graphic it
can allow inserting in it. The type of Slide Layout that you selected will
also determine the type of  placeholders in your presentation.

Slide View: Slide view displays the content or information in a sequence
and that can be controlled manually or automatically. Most of  the editing
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and formatting is done with this in mind as the impact of  all formatting
and text adjustments are viewed immediately.Displays one slide at a time,
as they will appear during the slide show (function key F5) or printed in
handout.

Tip: When you insert a new slide (Ctrl + M) in Slide View, it is always inserted after the
current slide.

Slide Sorter View: It displays every Slide within a presentation in miniature
view i.e. thumbnail preview. This allows you to view and follow the entire
presentation and make changes to either all slides or selected slides.

Tip: Press and hold the “Ctrl” key while clicking slides to select more than one slide at a time
in Slide Sorter View.

Transition: Special effects can be added to either a slide or for all slides
during a slide show. For example, you can fade in from black, or dissolve
from one slide to another.

Object: Any element that appears on a slide, such as text, drawings, clipart,
charts, sounds, and video clips. You can refer them as a text object, a drawing
object, a clipart object.

Presentation File: You can save the presentation in to hard disk, which
includes slides, images, audio & video etc…

5.6. Creating a Blank Presentation

Blank presentation allows you to build or add your own content like placeholder,
background colour, background image, and design choices in a slide. To create a new
Blank Presentation click on the “File” menu, select “New” presentation or press
(Ctrl+N).

Tip: Click on the Format menu, Slide Layout and select the Blank Slide.

Selecting the option “Slide Layout” in the Task Pane will display thumbnail
slide preview. Then click on Blank slide thumbnail to start designing. This will be
the first slide and you can have it as your title slide.
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Click on the placeholder “Click to add title”, a thick gray border appears around
the text box indicating that it is selected. Experiment your title slide by entering text,
changing colour of the text, changing the font size etc. After entering the title, click
on the subtitle text box and add text to that.

5.7. Creating Presentation from a Template

Templates are pre-designed presentations that contain a wide variety of  stylish
designs such as backgrounds, fonts, colors, objects, etc. Using these templates in
your presentation helps you to focus on preparing content instead of its design.
You can change the design template for individual slide or to all slides in that
presentation.

SOshow comes equipped with a number of designs or background templates.
When you select the design you will find that this presents the user with more than
just a background. In fact, the design will control many different features of the
slides. This includes the background image, text size, text location, text color, and
more.
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Click “Design Template” in the Task Pane, then right click over any one of
the thumbnail previews of  design template and click either “Apply to selected slide”
or “Apply to all slides”.

5.8. Editing text in Presentation

Now, you have a presentation with one slide. See if  you can add/edit  text..Select
the placeholder which displays “Click to add title” using the mouse or by pressing
(function key F2) to select the placeholder and enter text inside.
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Format the selected text inside the placeholder by applying desired Font Style,
Size, and Color using the respective box located in the formatting toolbar. By pressing
“Esc” key and using “Tab” key you can move around placeholders (notice a thick
gray border appears around the text box indicating which placeholder is selected).

To
move text and objects in a presentation, first click on the text object so that a gray
border appears around the text object. Then put the cursor on the box itself and
click once and while holding the mouse button down, move the text object. Alternately
we can use the arrow keys to move the selected text objects. Try moving the text to
different areas on the screen.

5.9. Insert a New Slide 

New slides will not be created automatically in Slide View. Click Insert menu,
New Slide. A new slide is inserted immediately after the working or selected slide.
Your presentation application uses the previous layout of  the slide for the new slide,
but we can select any of the design from the Slide Layout for that particular slide if
required.

Tip: To delete a slide in Slide View, click “Edit” menu and select “Delete Slide”.

5.10. Changing Slide Layouts

To change the layout for a slide, click “Format” menu and select “Slide Layout”.
Pick any one among the thumbnail images and apply or click “Slide Layout” in the
Task Pane, then right click over any one of  the thumbnail image and “Apply to selected
slide”.
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Note:- Bulleted lists allows the user to clearly display the main points of
your presentation on slides. The text boxes on design templates already
include bulleted lists. Click inside the placeholder to add text and press
the “Enter” key to return to the next line and then add a new bulleted
item.

Tip:- Slide Layout Symbols

Placeholder Description

Title Inserts a title or heading

Bulleted List Inserts a bulleted list of related points

Clip Art Inserts a picture, such as clip art or a graphic file

Media Clip Inserts music, sound, or a clip
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5.11. Reordering Slides

To reorder a slide in Slide Sorter View, simply click on the slide you wish to
move and drag it to the new location i.e. to change the sequence of slide during Slide
Show.

5.12. Opening a Presentation

Opening a presentation is similar to opening any other file i.e. press “Ctrl +
O” and select the (*.ppf) file. In File menu, recent files are listed in the bottom of
the menu..The last   four files are listed by default. If you want to open any one of
these files ensure that they are not moved or deleted from the specified location before
clicking on them.

Tip: History folder stores shortcuts to all recently opened files.
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5.13. Saving Presentation

While working on a presentation, a good idea is to save our work often; in
order to prevent losing the existing data. Click “File” menu, select “Save As”. The
Save As dialog box will appear. In the File name box, type a name (*.ppf) for your
presentation and click “Save” to save your presentation.

Tip: Click “Save” icon in the Standard toolbar.

5.14. Slide Show 

Click “View” menu, “View Show” to view from first slide or click Slide Show
button in Standard Toolbar. Using “right arrow” key you can move to the next slide;
similarly “left arrow” key for the previous slide.

While running the presentation first “Enter the slide number” using keyboard
and press “Enter” in the keyboard to display the specified slide (e.g. press “7” and
“Enter”, ensure that you have more number of slides in your presentation). Slide
Show will display slides in an on-screen presentation along with any animation and/
or slide transitions that you may have added to your presentation.

Tip: The keyboard shortcut for launching View Show (function key F5).

If timings have been set between slides, you need not press buttons or click
the mouse to proceed through the slide show; advancement occurs as specified.
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5.15. Resizing Text Box

Select any text box by clicking on it, a gray border with nine handle boxes will
appear around the text box. The four handles on the corners will resize the length
and the width of the box at once while the handles on the sides will resize only in
one direction. Try and click one of  the handles and drag it with the mouse. Release
the mouse button when it is the size you want it to be.

Tip: To delete a text box from a template, simply click the border of the text box and press
the Delete key on the keyboard.

5.16. Audio and Video  

To add sound in our presentation click “Insert” menu, “Sound from file”
and select a sound file and click OK. Similarly we can add Video by selecting “Insert”
menu, “Movie from file” and select a video file.

Tip: Audio and Video files inserted in any presentation will be run through during the Slide
Show (function key F5) only, but not in the Slide design view.

5.17. Background Properties

Changing the colors of pre-designed Slide templates and adding Color Scheme
to your presentations are made simpler and let us see now how you can add Color
Scheme and Background images to the slides.
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Click on the “Format” menu, select “Background” and select any one color
from the drop-down menu below the Background fill preview or choose “More
Colors” for a larger selection and then “Apply to selected slide” or to “All slides”
in your presentation.

Select “Fill Effects” from the drop-down menu to add gradient colours, texture,
pattern, or a picture to the background of any slide.

Gradient tab: Select “One color” if
you want to fade that chosen color
into the background from the drop-
down menu. Choose “Two colors” if
you want the gradient to use two colors
and select those colors from the drop-
down menus. Now select the type of
gradient from “Shading Styles” and
c l i ck  any  one  thumbna i l  p rev i ew
among the “Four Variants”.
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Texture tab: In the Texture window select a thumbnail image, so that it
fills completely in the slide.

Pattern tab: Select a two-tone pattern by
clicking any one of the pattern swatches and
then set “Foreground and Background
colors” for that pattern.
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Picture tab: Click “Select Picture” button to choose a picture file. On
selecting the picture, check in the preview window and click OK. Click
“Apply to All” to add the changes to every slide or “Apply” to make
changes only to the current slide.

5.18. Inserting Images, ClipArt   

You can use ClipArt in your presentations in as many ways as we like. Click
“Insert” menu, select “Picture”, “ClipArt” and then select any image in the ClipArt.
They are organised into thematic categories (e.g. Animals, Birds, Fruits, Furniture,
etc.).
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If you have a digital picture on disk and you want that to be inserted in your
presentation,  select “Insert” menu , “Picture”, “From file” and select the image
file (*.bmp. *.jpg, *.wmf, *.emf, *.gif). To re-size the picture select any image and
click on the “handle/grip” and drag it.



Shakti Office

120

5.19. Printing your Presentation

Click “File” menu, select “Print”, and select “All” to print all the slides in
the presentation, or enter slide numbers in the “Pages” field to print specified slides.

A handout consists of a smaller,
printed version of the slides. There can
be two, four or six slides per page. Use
the “Print Preview” option in the
“File” menu to print handouts.
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Select “File” menu, “Page Setup” and select the option “On-Screen show”
to prepare the presentation for slide show, i.e. electronic display of  the presentation
to the audience. Select any one of the formats to print slides from the drop-down
menu or enter a specific print size using the Width and Height boxes. Select the page
orientation for the slides. e.g. set “A4 Paper (210 * 297 mm)”, “Landscape”.

5.20. Ruler

Ruler is visible only in Slide design view (i.e. click “View” menu, Ruler). Rulers
are used to control the placement of objects on a slide and they are measured in the
unit of inches. When nothing on the slide is selected, the ruler measures full width
of the slide from the center outward.

5.21. Zoom

The Zoom feature allows you to adjust the on-screen magnification. Click
“View” menu, select “Zoom” and select the value in percentage say for example 75%,
100%, Fit, etc… to display the content, based on your requirement. This is particularly
useful when viewing details on a slide.

5.22. Drawing Tools

Drawing toolbar provides many commands for creating and editing graphics.
It is located at the bottom of the main screen, or enable this by selecting “View”
menu, “Toolbars”, “Drawing”. This toolbar contains icons for drawing rectangle,
ellipse, basic arrows, flow charts…

Rectangle Tool: Click on the Rectangle Tool. Place the cursor where you
want the rectangle to begin, click and hold the mouse button in, drag to
where you want the rectangle to end, and release. While dragging the mouse
button, move the mouse button up or down to make the object taller or
shorter; move it to the left or right to make it wider or thinner, or drag
it diagonally to make it larger or shorter.
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Ellipse Tool: Click on the Ellipse Tool. Place the cursor where you want
the ellipse to begin. Click and hold the mouse button in, drag to where
you want the ellipse to end, and release. While dragging the mouse button,
move the mouse button up or down to make the object taller or shorter,
move it to the left or right to make it wider or thinner, or drag it diagonally
to make it  larger or shorter.

Note:- If you want to draw a horizontal or vertical line, a square, or a
circle, hold down the “Shift” key as you move your cursor.

Text Box:  When you want to add text to your drawing, use the text
box. This will create text in the form of  a drawing entity and make
manipulation of  that text as easy as other drawing entities. Click on the
text box button and then select the size of your text box. Once you have
created the box , you can enter the text.

Line Color: To change the color of  a line that is already drawn, select
the line by clicking the mouse button on it, click on the Line Color tool,
and select the color you want.

Fill Color: Select the object by clicking on it, click on the Fill Color tool,
and select the color you want.

Basic Shapes: Click the Basic Shapes button on the AutoShapes toolbar
to select from many two and three-dimensional shapes. Use the drag-and-
drop method to draw the shape in the slide. When the shape has been
made, it can be resized using the open box handles and other adjustments
specific to each shape can be modified.

Block Arrows: Click Block Arrows and drag-drop any of the arrows in
the slide.

Flow Chart: Add flow chart elements to the slide and draw lines to connect
between the elements.

Stars: Click Stars and insert in any one in the slide.

Moving Objects and Lines: Select the object by clicking the mouse on
it and holding the mouse button in, move the line or object to the desired
position and release the mouse button.

Changing the Shape and Size of an Object: Select the object by clicking
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the mouse button on it. Click the mouse button on one of the corner
squares of the “Object Box”. While holding the mouse button, drag the
mouse button up or down to make the object taller or  shorter; drag it
to the left or right to make it wider or thinner, or drag it diagonally to
make to it larger or shorter.

5.23. Grouping

Images can be grouped together so they become one image and can be moved
together or the same formatting changes can be applied to both at once. Select all the
images that will be grouped by holding down the SHIFT key and clicking once on
each image. Select Group by right clicking on the object to be grouped. The images
can be ungrouped by selecting Ungroup from the same menu. The rectangles in the
image to the left are separate images with their own sets of handles and they are
grouped together in the image to the right.

5.24. Order

The order of overlapping images can be changed using this feature. In the
example of  two rectangles below, select a rectangle and right click and select “Order”,
using “Send Backward” command the rectangle is moved below the other rectangle.
“Send Backward” and “Bring Forward” will move elements by one layer. “Send
to Back” and “Bring to Front” move the elements to the back or top of a series of
several overlapping graphics.

Note:- If you just want to move an entity a little bit, select the entity
then use any one of  the Up/Down/Left/Right arrow keys.

5.25. Color Schemes

Click “Format” menu, select “Slide Design” and “Color Scheme” in the
Task Pane. Click any one of  the Color Scheme thumbnail preview images in the Task
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Pane and right click to select either “Apply to all Slides” or “Apply to the Selected
Slides”.

5.26. Animation Effects

Presentation has animation effects, including entry and exit animations, more
timing control, and pre-drawn paths that items in an animation sequence can follow
- so you can synchronize multiple text and object animations.

Preset animation provides a number of  “quick pick” animation effects. You
will need to first select the image or entity that you wish to animate. Then just pick
the Preset Animation effect you wish to use.

Slide Animation: First, select the slide in the slide sorter view pane and
click “Slide Show” menu, select “Slide Animation”. Several animations
for slides are available through the drop-down menus on the Task Pane.
Choose any one of  the options in the drop-down list e.g. Rise Up, Rise
Down, etc...

Custom Animation: Custom animation provides an extensive number
of animation variations for every text, image object. Click “Slide Show”
menu, select “Custom Animation”, and to animate the element (text, image,
etc.) click once on the element name and ensure that it is highlighted .
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Click “Add Effects” in the Task Pane. Select either “Motion Paths” or
“Basic” option and select any one of  the animation effects. The animation
timing can be altered using the drop-down list in the “Duration” option.

Slide Transitions: During the slide show you can add transition between
slides to enhance the presentation. Click “Slide Show” menu, select “Slide
Transition”, and select any one of  the transition effects from the “Apply
to selected slides” drop-down list. You can modify the speed of  transition
(Fast, Medium, Slow) using the drop-down list. Click on the “Import”
button to select a sound file to add to the slide transition.

Note:- Check on the box in “Transition auto after” and specify the
time delay to move from one slide to the other.
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5.27. Hyperlinks

While running the slide show,  if  you want to give more details to support
the presentation in the form of another document file or spreadsheet data file or
any external video files, you can create links for those file using Hyperlink.  First
select the object like placeholder, image and click “Insert” menu, select “Hyperlink”.
This  enables you  to assign a hyperlink to another file or to any of the files in the
Internet during presentation.

5.28. Pack and Go

You can view the presentation file created in one machine in another machine
by using the ‘ Pack and Go’ feature. Create the presentation and save it. Now click
“File” menu, “Pack and Go”, and follow the instructions in the Wizard. Choose
the destination (e.g. c:\My Folder) in which the file has to be packed.

Click on the check box, “Include fonts” to copy (i.e. English, Indian Language
fonts), and by default the wizard adds the player files in the pack. Click on the Finish
but ton to  s ta r t  compress ing  the  presenta t ion .  Now  you can  send the
CKPNGSETUP.EXE to anyone, so that they can double click the file to view the
presentation. This CKPNGSETUP.EXE also includes the application file, so it is
possible to modify any (*.ppf) file with the help of locally installed SOshow application.
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5.29. Keyboard shortcuts

Keyboard shortcuts can save time and the effort of switching from the keyboard
to the mouse to execute simple commands.

Document Actions

Open a presentation Ctrl + O

New presentation Ctrl + N

Save As F12

Save Ctrl + S

Print Ctrl + P

Presentation Actions

Begin slide show F5

Next slide ENTER or Down arrow key

Previous slide BACKSPACE or Up arrow key

Activate pen tool Ctrl + P

Erase pen strokes Ctrl + E

Deactivate pen tool Ctrl + A

End slide show ESC



Shakti Office

128

Formatting

Select all Ctrl + A

Copy Ctrl + C

Cut Ctrl + X

Paste Ctrl + V

Undo Ctrl + Z

Redo Ctrl + Y

Bold Ctrl + B

Italics Ctrl + I

Underline Ctrl + U

Left justified Ctrl + L

Center justified Ctrl + E

Right justified Ctrl + R

Editing

New slide CTRL+M

Spell checker F7

Insert hyperlink CTRL+K
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SOnet
A complete Web site builder, this versatile application runs in a WYSIWYG

(what you see is what you get) environment that makes it easy to create a stunning
Web presence. You can create tables, lists, style sheets with remarkable ease. Features
include regional language SOnet, wizards, color coding, tag inserts, etc...

Note:- Hypertext Markup Language(HTML), is the encoding scheme used
to create and format a Web document. A user need not be an expert
programmer to make use of HTML to create hypertext documents that
can be put on the internet.

6.1. Starting SOnet

To start SOnet you can click on the “Start” button at the bottom left corner
of  Windows 95/98/ NT desktop, select the “Programs” option of  the Start menu
and click on “Shakti Hindi Office”, from the Programs submenu. This invokes “SOnet”
and opens a new web page. To open a web page document in your browser, and use
a URL that specifies an absolute or relative location for the document. An absolute
location has the form:

http://domain-name/pathname (e.g.http://www.chennaikavigal.com/
index.html)

A relative location can either be relative to the root path for the current document,
in which case it begins with /, or relative to the directory containing the current
document, for example:

/products/index.htm

(e.g. Images/image1.gif.)

To open a local file in your web browser, use a URL that has the form:

File://directory/filename

(e.g. file://c:/My Documents/index.html)
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6.2. Creating your first web page

Creating a New Web Page : Use the New icon in the Standard tool bar
or New in File menu or use the blank page in the page template of  Task
pane

Design your web page: You can create basic web pages using the existing
Web page Templates that are available in the “Page Templates” list in the
“Task Pane”. Single-click on any template to display that page in the Preview
area. Select Normal Page if  you don’t know which template to choose.

Page Templates contains some predefined format (in Indian languages too)
which you can modify according to your choice, this feature will be available in the
corresponding Indian Language Interface. After selecting the Template, you can enter
the text inside the page (i.e. “Enter your Heading…..”).
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To change the web page background click “Format” menu,  “Background”
and select the appropriate background color, text color, hyperlink color, etc… and
on the other tab you can set the page margins in pixels.

The picture that appears in the templates can be modified or replaced by another
picture by right clicking on it and selecting the “picture properties”. You can also
insert a picture or video file by choosing the picture in the Insert Menu.
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To add effects for the web pages use the predefined transition effects that are
available in SOnet. Set page transitions for a particular type of event (Page Enter etc)
by selecting “Page Transition” from “Format” menu. In that you can  also set delay
time (durations) for transitions e.g. (e.g. Event – Page enter, Duration – 5 seconds,
Transition Effect – Box out).

You can create hyperlink for text, images by  right clicking on it and selecting
“hyperlink” from “Insert” menu or pressing Ctrl + K. You can create tables and
alter them using the commands in the Table menu. If  you want to modify the existing
table or cell,  right click on it and choose cell or table properties.

6.3. Refresh your web site

After opening any web page in either the standard browser or in the applications
“Preview” tab; sometimes it might take a long time to open the page, you may get
an error message saying your web page cannot be displayed. You may want to make
sure you have the latest version of the web page. Click on the “Refresh” icon or select
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“View” menu, “Refresh” or press functional key F5 to get proper display of the web
page.

6.4. Edit the source file (Html Tags)

To display or edit the source code of  the current web page (works even for
Indian Language web pages), click on the “Html” tab which resides in the bottom
of SOnet application.

Start hand-coding here to add or remove any attributes inside the Html tags
and preview the page by just clicking the “Preview” tab.
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6.5. Creating hyperlinks

A hyperlink is a connection between two pages on different locations on the
web. The destination of  the hyperlink is most often another Web page, but it can
also be an image, an e-mail address. Hyperlinks are created for text, image. For example,
a text link “CK Technologies” would indicate that the result of  clicking on that text,
would take us to the product detail page in the Chennai Kavigal web site. SOnet
underlines text hyperlinks and display them in specified HTML color tags (i.e. alink,
vlink, etc…).



Shakti Office

136

First select the text to be hyperlinked and press Ctrl+K shortcut key or select
“Hyperlink” from “Insert” menu. (you can also enter the text directly in the textbox
and choose the linking file as http://www.chennaikavigal.com/ products.html

F i r s t , select the image
and then press Ctrl+K and input the link address. Hyperlinks in images are invisible;
you can identify them by having a hand-shaped cursor over the image.

Tip:- Creating Bookmark is made simple in this SOnet i.e. creating anchor points (links) in
the same page, choose the “section of text in the document” and click “Bookmark” and enter
the bookmark name (create Bookmark By using Bookmark in the Insert menu) in the URL
text box.

6.6. Adding file to your current page

You can insert content from (*.html) external file into the current web page
by selecting “Insert” menu, “File”, “Filename” e.g. aboutus.html.

6.7. Using Frames in our web site

Using frames in our web page is just like adding information in another window.
Creating web pages with frames is quite interesting and helps easy navigation between
web pages.  Let’s see how you can use frames. Select “Tools” menu, “Wizard”, “User
Defined” and press “next” to continue. Now, enter the details for title of  the web
page and the location where it has to be saved.
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In the next step, select any one of  the Frame types “Left” among the drop-
down list and enter the appropriate file names for the first and second sections i.e.
menu file and the content file. Click on the Preview button to view the result and
then click Finish button.

Tip:- For each frame you can have a distinct URL (Uniform Resource Locater) that determines
the content displayed by that frame. You can add more detailed information like border width,
margin, resize, etc… using the wizard too.
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SOdraw
7.1. Introduction to SOdraw

Using this paint program you can easily create, edit, and apply various effects
to pictures. You can create web application pictures (e.g. button images, background
pictures, etc...) and re-size any image to the specified pixel dimensions. To start SOdraw,
first select “Start”, “Programs”, “Shakti Office Hindi” and click “SOdraw”.

7.2. Creating images in SOdraw

Select the “File” Menu, click New, and input the width and height for the image
in pixels (e.g. width as 400 and height as 300).

Then select the mode in which the image has to be created. For example, RGB
colors (Red, Green, Blue – This mode is preferred for using images in system display
i.e. on-screen). RGB colors (with Alpha) default value is set to 255, and it stores the
color information of an image. Click on the “Color” button to pick the background
color for the image. You can also select colors based on the name (e.g. black, brown,
red, yellow, blue, etc...). Note that the drawing area is defined with the background
color.

7.3. Changing the Fore Color

Another way to select or set color for an image is by selecting “Draw” menu,
“Settings” and “Fore color”, and adjust Red, Green and Blue sliders which are calibrated
in values ranging from 0 to 255.
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7.4. Drawing Tools in SOdraw

Use this icon to select an area of image.

Use this pencil tool to draw a free-form line, click and then drag
the pointer.

Use this line tool to draw straight lines.

Use this rectangle tool, by clicking on for first corner and then
drag the pointer for the other corner.

Use this ellipse tool to draw elliptical, circular shapes.

Use this polygon tool, by selecting consecutive points.

Use this bucket tool to fill color in the selected area.

Use this erase tool to fill back color in the image.

Use this text tool to draw a free-form line, click and then drag
the pointer.

In the text tool, SOdraw provides various parameters to control, how the
text has to appear.

Inside the Style selection, we have Single Line and Multi Line options.

Adjusting the width slider will either stretch the context or shrink it.

Character slider will control the spacing between characters in the text.

Text location is defined by the X and Y values. To rotate text, enter the angle
value in degrees for example 15.
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7.5. How to include texture for the text

To include texture for the text, check the texture box in the following dialog,
and select an image say for example, pic01.jpg.

In the “Style” drop-down list apply “Stretch to text” and the resulting image
will be as shown below.
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7.6. Drawing settings

Fore Color, is to set the fore ground for painting.

Back Color, is to set the background color fill.

Eraser Thickness, is to set thickness or size as Low, medium, High.

Anti-aliasing, controls the drawing edge (blur) in the current image. A
value of  “None” is no blurring. Strong makes the image more blurred at
the expense of speed.

Line Thickness, is defined in pixels for drawing line objects.

Line Style, defines the pattern that will be used for lines.

Style Name Description

Solid No breaks in the line

Dash Medium Even breaks

Dot Small even breaks

Dash Dot Alternating dashes and dots

Dash Dot Dot Two dots per dash

Fill Style, applies the color in the image.

Fill Style Description
None No fill

Horizontal Horizontal lines

Vertical Vertical lines

Forward Diagonal Diagonal lines. Bottom left to top right

Backward Diagonal Diagonal lines. Top left to bottom right

Cross Vertical and horizontal cross

Diagonal Cross Diagonal cross

Solid Completely filled.
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Transparency, defines how an opaque or transparent drawing will look
(i.e. 0% is completely transparent and 100% is completely opaque).

7.7. Applying Effects

You can enhance an image just by applying an effect to that.

Palette dithers an image to get the best result on screen.

Palette Black and White Palette - 16 Colors Palette - System
(2 colors, black and white). (Standard windows (The current windows

16 colors). system colors).

Palette -  Web Palette (In this palette each primitive is a multiple of  51.
(0, 51, 102, 153, 204, 255). With six possible values per primitive and 3
primitives (red, green and blue) the maximum colors are 216. (6^3=216)

Crop replaces the image with a cut out (portion) of the original.

Crop method
Top Left Top Right Bottom Left Bottom Right Center
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Dither applies a color quantization algorithm to reduce the number of colors
used within the image.

Dither
2 Colors 4 Colors 32 Colors 256 Colors

Drop Shadow effect will add an alpha blended to the image. Drop shadow
follows the contours of  existing alpha information. The image will be
increased in width and height by the value of  Offset in X and Y.

Flip the image either horizontal or vertical.
Flip - Horizontal Flip - Vertical

Resize will change the canvas and stretch the image to fit inside.

Resize - Enlarged Resize - Reduced
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Rotate an image with angles multiplied by 90 degrees. However, the image
may be rotated at any angle. If the angle is not a multiple of 90 then those
areas will be filled with the supplied back color and opacity.

Skew effect will slant the image either horizontally or vertically. It will
fill the blank area with the supplied back color.

Horizontal Skew – 45 degrees Vertical Skew – 45 degrees

Thumbnail shows the image in a standard size. Thumbnail browser is
tree-based, and similar to the Windows Explorer. This makes the image
file management easier and more intuitive. Select a folder to display smaller
preview buttons, called thumbnails, of  the images within that folder. Double
click an image to open or select the image and click OK.
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7.8. Filters

Auto Brightness adjusts the brightness of the image.

Before applying Auto Brightness After applying Auto Brightness

Blur filter makes the image look fuzzy.

Brightness and Contrast, Enhances the picture quality (e.g. Brightness:
7, Contrast: 20).

Hue, Saturation, Luminance filter converts a color described in hue,
saturation and luminance into red, green and blue. Hue is an index into
the spectrum of  basic colors. Saturation is a greyness quality. A color
that has a high saturation is very colorful and vibrant. A color that has
low saturation is more greyish. Luminance is the brightness of the color
(e.g. Hue:27, Sat:255, Lum:0).
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Colorize filter allows a constant hue, saturation and/or luminance to be
applied to the image data. Each color in the RGB color model may be
described uniquely by their hue, saturation and luminance properties.

Edge detection will add an alpha blended drop shadow to the image.
This shadow follows the contours of  existing alpha information.

Emboss filter will detect linear changes in adjacent pixels and creates a
beveled effect in the image.
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After applying Emboss

Gamma filter calibrates and standardise the contrast and brightness, color
balance, and white points of an image.

Intensity filter makes the image look bright.

Mosaic filter averages the colors of surrounding pixels and results in “big
pixels”.
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Negative filter inverts an image to a different color like white, red, green,
blue or any given color.

NegatoveNegative Negative     Negative        Negative
White Red Green     Blue        Lemon

Sharpen filter increases the contrast of adjacent pixels in focus, blur
photographs or scanned images, which are used for printing. This filter
or technique is used in traditional film compositing to sharpen edges in
an image.

Soften filter will soften or smoothen the image.
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Unsharp Mask is a high-frequency enhancement filter that brings out edges
and point details.

Color Etch Halo Effect

Vibration filter gives an image a blurred effect

Other custom filters
Oil Painting Night Line


